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Chapter 1

Key Relationships
This chapter provides information about the following:

Welcome to Sage Master Builder and Your Business

About Key Relationships

Production Activities Specialized for Contractors

Accounting Activities Specialized for Contractors

Analysis Specialized for Contractors

Communications Specialized for Contractors
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Chapter 1
Welcome to Sage Master Builder and Your Business

Sage Master Builder - A better way to run your business

Welcome to Sage Master Builder. Sage Master Builder is an integrated, 
construction-specific, estimating, accounting, and project management 
software solution. Whether you are a general contractor, a subcontractor, 
or service contractor, Sage Master Builder manages your business using 
one system.

Sage Master Builder provides many features that are beneficial for cus-
tomers with complex environments that may include remote connections, 
many simultaneous users, and/or multiple companies.

About this book

Whatever need has motivated you to buy and use Sage Master Builder, 
tools in the program can help you run a more profitable business. As with 
any powerful tool, it's best to take advantage of training opportunities to 
help increase your understanding Sage Master Builder. With that under-
standing, you will become an efficient and effective user. 

Reading this book, Sage Master Builder and Your Business, is one way to 
start your Sage Master Builder training. It is not intended to show you 
specific installation steps or the how-to of program use. Instead, it leads 
you through three levels of concepts important to understanding how 
Sage Master Builder works. This book provides a bridge from the high-
est level overview of Sage Master Builder to a more detailed level. It 
provides the insights necessary to help you work effectively with a busi-
ness partner while working through business implementation issues.
2
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About Key Relationships
Key relationships in Sage Master Builder are in five major areas and are 
explained in further detail:

• Initial acquisition of your customer – sales, estimating, and propos-
als.

• Production activities specialized for contractors – these include the 
items that get the work done: POs, schedules, change orders, and 
more.

• Accounting activities specialized for contractors – AP, AR, Payroll, 
and more that are designed with the contractor in mind.

• Analysis specialized for contractors – near real-time analysis of jobs, 
job profitability, and the overall health of your business.

• Communication with your business partners – use the outputs and 
products of the prior four areas in a full array of communications.

As you read these topics, note that they are in the order you typically will 
follow for a construction job. Some of the groundwork for how you 
implement Sage Master Builder is discussed in the section, “Underlying 
Concepts.”

Acquiring Your Customers

Acquiring your customers is generally the first step as you work through 
the normal business cycle. With Sage Master Builder, you can use exist-
ing prospecting and sales methods in your company or build upon Sage 
Master Builder and third-party capabilities. After finding your prospects, 
you use the estimating tools of Sage Master Builder or your current sys-
tem to develop estimates that will drive proposals, production, and job 
analysis. 

The components of acquiring your customers (sales, estimating, takeoffs, 
and proposals) are discussed in more detail in the next few paragraphs.

Sales

Sage Master Builder provides solid sales management and tracking. With 
a client database, you can use Sage Master Builder to manage sales leads 
from the first contact to signing the contract. In each client record, you 
can assign a salesperson to be responsible for managing the client and to 
3



Chapter 1
keep comprehensive notes about the client over the course of the sales 
process. Using the lead source list and the unique client reports, you can 
see how advertising and promotions are generating leads and closing 
sales.

Determining when to place follow-up calls is another important aspect of 
sales and client relations. To streamline the follow-up process, a sales-
person can enter a callback date in a client record. Based on a callback 
date, the salesperson can quickly generate a list of clients to call for the 
next day or week, making the follow-up process simple and efficient.

After a contract or work order has been issued, the client database 
becomes an important part of making repeat sales, renewing service con-
tracts, and other selling opportunities.

In addition, integrated applications from third-party vendors can provide 
more advanced CRM and sales management tools. For more information 
about third-party vendors, please review this page: 
http://www.sagecre.com/partners/development_partners/
complementary_products

Estimating

After identifying a prospect, the next step in acquiring a customer is cre-
ating an accurate estimate of the work for the prospect.

Sage Master Builder Estimating supports good business practices by:

• Helping you manage risks by explicitly including risk factors for all 
elements of a bid or by using different billing methods.

• Helping you delineate the bid you present your customer from the 
budget that measures your costs.

• Helping you manage labor with measurement and control of both 
hours and burdened labor costs.

The Estimating add-on module makes the estimating process fast and 
accurate. It is fully integrated with scheduling, project management, and 
accounting functions. Because it combines the best features of a database 
and spreadsheet, the Sage Master Builder Estimating module offers one 
of the easiest-to-use, assembly-based estimating solutions on the market 
today.
4
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Estimating can be the start of your production activities by creating items 
such as budgets, proposals, purchase orders, and subcontracts.

There are many third-party estimating tools available that work with 
Sage Master Builder, thus extending Sage Master Builder's integrated 
accounting and project management tools to meet the special needs of 
your trade. For more information about third-party vendors, please 
review this Web page: 
http://www.sagecre.com//partners/development_partners/
complementary_products

For details of Sage Master Builder's estimating process, see the sections 
about “Takeoffs” and “Assembly (Estimating).” Estimating is an add-on 
module, but you may be able to integrate your own estimating methods 
into Sage Master Builder.

Takeoffs

A takeoff is the Sage Master Builder concept that encompasses building 
an estimate. This functionality is a key to starting the Sage Master 
Builder profit cycle. You can use bid items and job phases to organize 
your projects. Then, using the parts and assemblies databases, you can 
quickly build a takeoff for any project. The takeoff is how you translate 
your customers' needs into estimates of material, labor, subcontracts, and 
other costs.

Once completed, you can examine the anticipated project costs through a 
variety of takeoff reports. You can also export the information to auto-
matically create budgets, proposals, change orders, purchase orders, and 
even service work orders.

If you have an estimating system that is trade-specific and works for you, 
you can import the estimate from that system and then use the rest of 
Sage Master Builder to run your business.

Takeoffs are part of the Estimating add-on module.

Proposal

The proposal is a document presented to a client, providing a breakdown 
of the contracted amount by cost code or bid item. Sage Master Builder 
provides several ways to create a proposal: you can export the data from 
a takeoff, import a budget, import a file, or create a proposal manually.
5
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Using a variety of custom-designed document formats, you can then 
print the proposal, enabling you to produce the most professional and 
complete proposal possible.

Proposals can take advantage of Sage Master Builder's form design tool. 
With the form design tool, it is easy to build and customize a multi-page 
proposal that includes a cover sheet, the contract, and itemized price 
sheets for specific job requirements.

Once the proposal is completed, you can set the original proposal. After 
negotiating the price with your client, you can edit the current proposal 
and compare it with the original.

If it becomes necessary to adjust the selling price in a proposal, you can 
create change orders to track the extra work and revenue. Change orders 
allow you to alter the selling price independent from the proposal itself.
6
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Production Activities Specialized for Contractors

About production activities specialized for customers

Sage Master Builder excels at the production activities you need to suc-
cessfully deliver your jobs. The results of the production activities are 
automatically entered into accounting systems so you do not have to 
waste time with duplicate data entry.

Production

After estimating and securing a job, production activities ensure the 
timely and profitable delivery of a job. A few key controls can help you 
track your production:

• Controlling change orders is vital. Don't lose track of this source of 
added profit.

• Controlling schedules can help you complete jobs more timely with 
lower overhead per job. You'll also keep subcontractors happy with 
up-to-date schedules.

• Controlling materials can make sure all the parts needed for specific 
tasks are on-site when needed.

Beyond these key items, Sage Master Builder encompasses the following 
as part of production:

• Proposals

• Budgets

• Job cost

• Scheduling

• Purchase orders

• Subcontracts

• Change orders

• Automated cost-to-complete analysis

• Equipment management

• Document control
7



Chapter 1
For all of these production items you can use reporting to identify and 
correct areas that need management attention.

Schedule

Using 10-Scheduling, you can create a schedule to plan and manage a 
project, regardless of its size. A schedule allows you to budget time, plan 
when some tasks begin in relation to other tasks, and set milestones. You 
can also set up tasks for billings or inspections and identify scheduling 
conflicts between resources. You can analyze the accuracy of time esti-
mates, track the progress of jobs, and adjust tasks or resources to keep 
projects on schedule.

Purchase Order

A purchase order lists the materials needed from a specific vendor for a 
specific job. You can create purchase orders manually for each vendor, or 
export data from the takeoff to create purchase orders automatically for 
each vendor. In addition, you can create purchase orders for the subcon-
tractors on a given project.

With large projects, you can create master purchase orders. A master pur-
chase order contains all the parts needed from a vendor, but allows you to 
create smaller purchase orders to help schedule the flow of materials to 
the job site. For instance, you can stagger the purchase and delivery of 
framing materials to better coincide with the different phases of con-
struction.

After creating purchase orders, you can generate job cost reports to deter-
mine committed costs. As you receive shipments of materials, employees 
can enter the quantities of materials received using purchase order 
receipts, which create a payable invoice. When you receive the payable 
invoice from the vendor, you can review the invoice record and make 
any necessary adjustments.

You can use a vendor-specific warning system to prevent you from pay-
ing an invoice without entering a PO number or to alert you if an invoice 
exceeds the PO amount. In addition, PO audit reports indicate over-
charges on any line of the PO so that you won't mistakenly overpay, even 
for small items.

The program provides the functionality to attach POs to email messages 
or fax them to vendors.
8
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Subcontract

Many contractors use subcontracted labor to perform specific types of 
work, such as electrical wiring, plumbing, framing, sheetrock, and so 
forth. Using subcontracts along with change orders and invoicing, you 
can create and monitor subcontracts, review change work, and create 
invoices that affect subcontracts to gain tighter control of subcontract 
billings. 

You can export items from a takeoff to automatically create subcontracts, 
or you can enter the subcontracts manually. You can review billings, 
approved and open change orders, or a summary of the subcontract infor-
mation. 

You can also set up retention for a subcontract. When you create an 
invoice for the subcontract, Sage Master Builder uses the rate indicated 
in the subcontract record.

Request for Proposal

A Request for Proposal (RFP) is a document you send to vendors or sub-
contractors containing a list of parts needed or work to be performed. 
The vendor or subcontractor uses the RFP to create a proposal for you 
containing a list of parts needed or work to be performed. 

Sage Master Builder supports RFP and RFI numbering by job, and if the 
job has phases, by job and phase. This feature makes it easier to keep 
track of RFIs and RFPs because they are associated with the job in which 
they were initiated. 

RFPs can be generated directly from the takeoff screen. A number of key 
date fields allow you to manage RFPs through the bidding process. 
When accepted, you can easily turn RFPs into purchase orders.

Change Order

Change orders provide powerful tools for managing changes to a prime 
contract or subcontract. Change orders allow you to track changes 
independent of a project’s budget, providing a clear audit trail for 
pending, approved, and refused changes.

Depending on the type of change work you need to perform, you can 
enter change orders that alter the job’s budget, proposal, or subcontracts, 
or any combination of the three. You can enter changes to costs that 
9
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affect the bid amount. Then you can enter cost changes that affect your 
budgeted costs such as subcontract changes, or work for which you do 
not want to charge the client.

Change orders are now more closely integrated with subcontracts. When 
you create a change order for a subcontract, information is displayed on 
the subcontracts window in columns.This tight integration provides more 
control over your contracts and your invoicing by providing easily acces-
sible information. 

Service Management

Service Management includes service contracts, service routes, service 
dispatch, on-call work orders and quotes. Because service management 
functionality fully integrates with the inventory, you will be able to keep 
inventory up-to-date when service work is performed.

Service client data supports multiple locations for every client and lists 
of installed equipment at every location so that you can track what was 
done on any piece of your client's equipment.

As you create records, you can use the dispatch board to schedule the 
service call and provide the location of the work and the parts and assem-
blies necessary to complete the work.

When performing service work for insurance recovery, you can also sup-
ply necessary policy details.

Service Management is part of the Service Receivables add-on module to 
Sage Master Builder.

Project Management

Project Management includes most of the tools in the production portion 
of the profit cycle. The specific project management tools that come inte-
grated as part of Sage Master Builder are:

• Budgets

• Job cost setup and job cost management

• Job cost and budget reports

• Purchase orders

• Subcontracts
10
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• Change orders

• Cost to complete tools

• Proposals

• Unitary proposals

• The Project Work Center

• Document control

Project Management is part of the core Sage Master Builder system.

Document Control

Using document control functionality, you can track  important project 
management documents and maintain complete control of every item 
needed for a project. Requests for information (RFIs), requests for pro-
posal (RFPs), transmittals, submittals, daily field reports, and correspon-
dence all integrate with estimates, change orders, purchase orders, 
subcontracts and payroll, thus making the process of project management 
complete, fast, accurate, and reliable.

You'll be able to manage correspondence, keep track of project plans, 
maintain a project hot list, and stay on top of punch list items. A custom-
izable template makes daily field reports accurate and easily accessible.

Document Control is located under Project Management.
11
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Accounting Activities Specialized for Contractors

Accounting for Construction

Fully integrated accounting with automated job costing is the backbone 
of Sage Master Builder. Sage Master Builder accounting meets account-
ing needs and your special needs as a contractor. Sage Master Builder 
accounting includes:

• Managing key compliance issues such as workers’ compensation, 
liability insurance, bonding, and more.

• Distinguishing between overhead and direct costs, and then compar-
ing budget to actual job costs.

• Driving job control through purchase orders. Job costing is not 
dependent upon accounting staff but starts when the information is 
generated by project managers.

• Billing easily in a variety of ways so generating income is an easy 
part of your operation.

The accounting system includes:

• General ledger

• Accounts receivable (with many invoicing options)

• Accounts payable (bill paying)

• Payroll (with direct deposit)

• Equipment costing and management
12
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Add-on modules that are integrated with accounting are:

• Estimating

• Combined Service Receivables and Inventory

Sage Master Builder integrates all estimating, production, and analysis 
tasks fully with the accounting system. A major key to this integration is 
the ability to track all job estimates, costs, and committed costs. Then 
you can use standard reports or create new ones so you always track your 
profit and loss from each job.

General Ledger

The General Ledger forms the backbone of the accounting system. it 
receives information from all functions that affect the accounting pro-
cess, including accounts receivable, accounts payable, payroll, inventory, 
and service receivables. You also can make entries directly into the gen-
eral ledger for cash, checks, deposits, journal transactions, and recurring 
transactions.

The General Ledger supports up to 10-digit account numbers. True sub-
sidiary ledgers are maintained so that financial statements are simplified.

All 12 accounting periods for the year as well as the twelfth period of the 
prior year are available for posting, and you may control posting to any 
period. Entries made to the prior year will automatically update the prior-
year ending balances as well as the current year beginning balance.

You can print custom financials and multi-company financials as well as 
standard accounting reports at any time for any period. A bulletproof 
audit trail creates a secure system from accounting to job costs, complete 
with automatic auditing of all stored balances back to their original 
entries.

Accounts Receivable

The Accounts Receivable system serves as a marketing, sales contact, 
and document management tool, as well as a means of managing receiv-
able accounts. The client database contains sales information for tracking 
prospects from the first point of contact to the close of a contract and 
completion of a job. Client documents includes standard sales letters, 
notifications, and other client related forms. For each client, actual work 
13
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is associated with jobs. Jobs are discussed in more detail in Chapter 2, 
Underlying Concepts.

Four special billing options are available for Accounts Receivable - 
progress billing, unitary billing, loan draws, and time and materials bill-
ing.

Statements and other documents contain full contract summaries. You 
can add any information from the job or client databases to these docu-
ments. Call sheets and aging reports are also available for efficient col-
lection management and processing. You can produce aging reports at 
any time, which can be 'as of' the end of any prior fiscal period to match 
financial reports for the same period.

Accounts Receivable is part of the core Sage Master Builder system.

Accounts Payable

The Accounts Payable system is fully integrated with purchase orders, 
subcontracts, job cost, and inventory. You can complete your entire 
invoice entry in one step when you enter a purchase order or subcontract 
number. Sage Master Builder compares each line of the invoice to the 
purchase order, preventing over-pricing or over-delivery of items without 
your approval.

By tracking expiration dates on Workers' Compensation, liability insur-
ance, and contractor licenses, Sage Master Builder can warn you before 
you pay subcontractors who have not supplied you with current docu-
mentation. In addition, you can track each subcontract separately to pre-
vent payment if there is a dispute over the contract.

You may select from a wide variety of check formats or create your own. 
Choose multiple check stubs or special check reports to list all of the 
invoices paid. You can make a partial payment or designate dual payees 
on any invoice, and decide which credits to apply to a payment prior to 
running checks. You can even override discount dates to take discounts 
that have expired.

Aging reports can be run as of the end of any prior period to match finan-
cials even after the period has been closed. Compliance reports and 1099 
forms are also included in the extensive reporting options.

Accounts Payable is part of the core Sage Master Builder system.
14
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Payroll

5-Payroll is one of the core modules provided with Sage Master Builder 
that helps provide complete integration with job costs. The payroll func-
tionality includes many cost savings features, such as handling complex 
workers’ compensation. In addition, the program provides functionality 
for working with local taxes, payroll groups, union payrolls, certified 
payroll, and multiple ways to enter your data.

Payroll automatically generates accurate labor costs by calculating all 
your accruals as well as basic pay items on a line-by-line basis for every 
timecard. You will get the most accurate cost of payroll possible. Even 
liability insurance and small-tool costs can be included in the payroll cal-
culations and automatically posted to job costs. You also can include any 
of the standard 401(k), “cafeteria,” and qualified benefit plans to save 
money on payroll taxes and workers’ compensation.

Payroll supports all workers' compensation systems, including split rates, 
hourly calculations, and in some states employee and employer portions. 
Special reports are available for states with different workers' compensa-
tion calculations, such as Nevada, Oregon, and Washington.

For large payrolls, Sage Master Builder provides daily field and staffing 
reports. Daily Payroll can be integrated with equipment management for 
allocation of equipment repair time and equipment cost to projects.

Equipment Management

Equipment management is an integral part of maintaining a profitable 
business. The ability to analyze equipment costs ensures that you not 
only recover costs but also make the equipment profitable. With the 
Equipment module, you can track a variety of ownership costs including 
loans, loan payments, and maintenance as well as examine equipment 
costs and revenue.

For each piece of equipment, you create an equipment record to track 
important information such as loans, cost rates, rental rates, and depreci-
ation. In each equipment record, you can set the rate at which you 
recover costs for the equipment.

As you use equipment, allocate the equipment time to jobs or to other 
equipment for repairs. Suppose that a backhoe is used to lift the engine 
out of a bulldozer for repairs. The program creates an equipment-cost 
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record for the use of the backhoe based on the cost recovery rate and the 
length of time it was used. When you allocate the backhoe to a job, the 
program creates job cost and revenue records. With a database of job cost 
and revenue records, you can then analyze the profitability of your equip-
ment.

Inventory

The Sage Master Builder Inventory control system lets you keep track of 
the inventory flow, from the time you receive it, to the time you consume 
it. Inventory control helps track how much of a particular item you have 
in stock, where it is located, how many are committed to jobs, and even 
how many to reorder when stock is low.

The inventory control system is integrated with the rest of Sage Master 
Builder. When you enter payable invoices, service receivables credits, or 
purchase order receipts, the program moves the parts into inventory, even 
individually serialized parts. In the 9-2 Parts window, you can select a 
part and view how much stock is on hand, how much is available, and to 
which locations it has been assigned. When you create service invoices, 
Sage Master Builder automatically removes the parts from inventory. 
You can also manually remove parts and job cost them using Inventory 
Allocation.

Service Receivables and Inventory are a combined add-on module.

Service Receivables

Service Receivables includes quotes, point-of-sale and billing-of-service 
work and materials. Because Service Receivables is fully integrated with 
Inventory, you will be able to keep inventory up-to-date as you invoice 
service work.

Service Receivables includes quotes, point-of-sale and billing-of-service 
work and materials. Because Service Receivables is fully integrated with 
Inventory, you will be able to keep inventory up-to-date as you invoice 
service work.

Service Receivables functionality helps you quickly enter work orders, 
invoices and credit transactions that affect service receivables accounts. 
You can create quotes, work orders, invoices, credits, and service routes 
and contracts. You can also view many different summaries such as ser-
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vice contracts for clients, client equipment, equipment by location, 
quotes, work orders, and open invoices.

Service Receivables integrates with payroll so you can directly import 
hours from your service work orders.

When performing service work for insurance recovery, you can also sup-
ply necessary policy details.

Service Receivables and Inventory are a combined add-on module. 
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Analysis Specialized for Contractors

Analysis

Now let's consider the concept of job analysis. Many contractors tend to 
think of jobs independently. Sage Master Builder has the tools for you to 
analyze each job and apply the insights learned to the next job. You can 
analyze single jobs while you are working on them. You can also use 
such tools as the committed cost or cost to complete reports.

Then as the job is nearing completion, as part of your job closing work-
flow you can:

• Create, manage, and clear punch lists

• Review all job costs, especially those unbilled from vendors

• Ensure that all change orders have been billed to the customer

• Compare job costs to budgets

When you have completed a job, you can then contrast and compare 
groups of jobs. In addition to comparison reports, Sage Master Builder 
provides graphical project review analysis where you can visually com-
pare various selections of jobs.

For your business as a whole, Sage Master Builder provides financial 
review with a wide range of key charts that can be viewed or printed in 
line, bar, or 3D bar for current year, 12-month or 12-month rolling peri-
ods. Among the many graphs available are current ratio, quick ratio, 
gross profit/sales, net profit/sales, and overhead to direct expense. In 
addition, trend graphs are available for cash, accounts receivable, 
accounts payable, sales, gross profit, net profit, break-even, and working 
capital.

With over 1200 reports, Sage Master Builder provides you with the tools 
to analyze your business the right way for you. If you do not find the 
exact report you need, you can turn to the Report Writer and develop the 
report you want. To complete complex reports, you may wish to consult 
with a business partner.

Report Writer

The Sage Master Builder Report Writer allows you to create custom 
reports that access information stored in the Sage Master Builder data-
18
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bases. With Report Writer, you can modify existing reports or create alto-
gether new reports for your company needs.

Before using the Report Writer, however, review existing Sage Master 
Builder reports to see if there is one that you can adapt your processes to 
use. With over 1200 reports, Sage Master Builder probably has one to 
suit your needs.

The Report Writer has a wizard that walks you through the process of 
creating your own reports. You can use most standard reports as a start-
ing point for creating your own.

Query

Queries are a powerful feature for analyzing your data and your business. 
When you query a database, Sage Master Builder locates all the records 
that match your criteria and displays the results in a Quick Report win-
dow. You can then use drill-down capability to select a record for review. 
You can also copy the results of a query into a spreadsheet. Queries are 
supported by a Query Wizard to get you started with a minimum of 
effort. Queries are a key feature for customizing Sage Master Builder for 
the way your business runs.

Executive Dashboard

Sage Master Builder has a powerful feature called the Executive 
Dashboard. The Sage Master Builder Executive Dashboard has been 
designed for busy construction executives. At a glance, it shows you the 
state of your company’s finances in real-time by displaying information 
under seven major category headings. 

To enhance the power and flexibility of the Executive Dashboard and 
Sage Master Builder accounting in general, you can now drill down into 
Sage Master Builder financial reports from the Executive Dashboard, 
and from those reports to other reports or transactions within Sage 
Master Builder windows. 

About program-wide drill down into reports

Sage Master Builder provides over 1200 in-product reports to enable you 
to analyze the state of your business from many different perspectives. In 
addition to the information available on reports themselves, you can also 
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“drill down” into the report information contained in the report’s rows 
and fields. 

Viewing reports in print preview also provides the platform for report 
drill down. When you are viewing a report in print preview, if there is 
drillable information on that report page, your cursor becomes a 
magnifying glass. When the lens displays a red circle, you can double-
click the row or field.
20



 Key Relationships
Communications Specialized for Contractors

Communications Specialized for Contractors

Communications capabilities are available throughout Sage Master 
Builder. You can stay in touch with:

• Clients

• Prospects

• Employees

• Vendors

• Subcontractors

• Architects

• Engineers

• Banks

• Government agencies

• Unions

• Insurance companies, and more.

For each of these audiences, you will find that Sage Master Builder pro-
vides specialized and customizable reports and forms from every func-
tional area of the system. These reports and forms are designed with the 
contractor in mind. For instance, you can print contracts with detail notes 
automatically imported from takeoffs.

As discussed in related topics, Sage Master Builder provides the means 
to fax and email all these communications to your business partners. 
With Scheduled Reporting, you can have these communications take 
place automatically, at any time of the day.

You can also communicate by sharing files. Some areas of Sage Master 
Builder provide specialized formats but you can also use the export to 
excel capability discussed as part of analysis.

Attachments provide functionality to attach files and/or Web links to 
selected records in Sage Master Builder. You can simply drag and drop 
files and/or Web links onto Sage Master Builder windows that accept 
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attachments, such as AP invoices, subcontracts, and requests for 
proposals.

Finally, a much larger world of communications is opened when you use 
the Sage Master Builder Application Program Interface (API) with spe-
cialized third-party programs. 

To view the product developed for Sage Master Builder using the API, 
browse to this link: 
http://www.sagecre.com/partners/development_partners/
complementary_products

Report Scheduling

Report scheduling provides the functionality so that you can schedule 
most reports to print at a specific time and for a given frequency. You can 
also specify the output options (print, fax, or email) for the report and 
determine to whom it should be sent. There are specific system require-
ments for faxing and emailing reports.

This powerful tool gives you the ability to control and manage your data 
on a regular basis. It provides specific reports and forms that you can 
send directly to your vendors, clients, and employees.

You can specify whether the report should be sent to the printer, a fax 
distribution list, or an email distribution list. You can specify when and 
how often the report should be run. Recurrence lets you designate a spe-
cific end date for the report or the total number of times that the report 
should be generated. For email and fax reports, you can include a subject 
line and message.

Scheduling is not possible for reports that print checks, post to general 
ledger, or require secondary input.

Emailing and Faxing

Emailing and faxing from Sage Master Builder provide the communica-
tions tools you need to get information to your business partners and staff 
when they need it. You can email or fax almost all reports from Sage 
Master Builder to either a single person or to a full distribution list.

You can email and fax as you create reports. Using the report scheduling 
feature, you can have email messages and faxes sent at specific times and 
on a recurring basis.
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Application Programming Interface (API)

An API is a set of programming tools for developers to interface to a spe-
cific application. Many programs provide APIs to allow third-party 
developers the capability to integrate with and extend the basic capabili-
ties of the program.

The Sage Master Builder Application Programming Interface (API) pro-
vides access to a Sage Master Builder Company database via a COM 
method call. The call has input parameters containing an XML string that 
tells the API what to do in the specified company database.

The API supports access to over 65 Sage Master Builder objects, cover-
ing most areas of interest except general ledger transactions.

For further details about joining the Sage CRE Development Partner Pro-
gram, and current partner products, visit 
http://www.sagecre.com/partners/development_partners  

NOTE: 
For all the details about faxing from Sage Master Builder, see 
the Installation and License Administration Guide. 
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Chapter 2

Underlying Concepts
This chapter provides information about the following:

Underlying Job-related Concepts

Underlying Accounting-related Concepts
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Underlying Job-related Concepts

About underlying job-related concepts

Before you continue your Sage Master Builder education with function 
area information, there are a few important topics you need to know 
about. The topics discussed in this section are very important because 
your choices and understanding about them will influence every area of 
Sage Master Builder. If you are unclear about any of these topics or why 
they are important, be sure to talk to your business partner or take the 
appropriate training classes.

Job-related concepts and job costing

Jobs and job costing are key components of Sage Master Builder. Many 
aspects of the system are set up to support job costing. Good job costing 
helps produce some of the most important benefits of Sage Master 
Builder, such as budget to actual reports and job profitability analysis.

Cost Code

Cost codes are an important part of the job costing system. They allow 
you to separate costs into different categories and compare budgeted 
costs to actual cost for a job. Each cost code is assigned to a division, 
which provides a way to group cost codes for subtotaling on reports. 
Sage Master Builder organizes job costs in order of detail by job and 
phases, cost codes, and cost types.

When you set up a list of cost codes, Sage Master Builder uses the list 
throughout the entire company; all construction projects use the same 
list. Because the cost code structure relates to an individual company's 
estimating and cost gathering methods, you can create a different cost 
code structure for each company. However, using different cost codes for 
the same type of work performed across different projects or companies 
can prove confusing and potentially cause inaccurate data.

You can also assign workers’ compensation codes and departments to 
cost codes, providing default information during timecard entry. The 
workers' compensation code ensures that you correctly assign compensa-
tion codes for work performed. For states with split rates, you can also 
set up a wage maximum and a second compensation code.
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The cost code can contain a department, which the system will find while 
looking at the job record during timecard entry. If the cost code does not 
indicate a department, the program will then look at the employee posi-
tion for information.

Job

In Sage Master Builder, a job encompasses the work and materials for a 
specific project for a specific customer. Simply speaking, the job is 
where you do the work, and the client is where you send the invoice. For 
each job, Sage Master Builder stores and develops the job-related infor-
mation such as important identifying information, contract dates, job bal-
ances and costs, and contract terms. In addition, job functionality 
provides a variety of tools to help manage contracts. You can supply 
information for creating pre-liens and lien releases, and create phases to 
divide work into more manageable sections. You can also create bid 
items to divide the estimate into more measurable or customer-required 
sections. 

You can also provide billing information such as the client, job architect, 
engineer, or project lender. For instance, when you supply the client 
number, the program includes the client information on invoices printed 
for that job. If you include the architect or engineer name in the job 
record when using progress or unitary billing, the program uses that 
information when creating a progress or unitary bill. If you include the 
lender, the program uses the lender information when creating a loan 
draw document.

Job Cost

Job costs are the detailed cost records about a specific job. Accurate job 
costs provide the way to analyze costs and refine the estimating or bud-
geting process. When you post a transaction to the Direct Expense or 
WIP range of accounts, Sage Master Builder prompts you to create a job 
cost record. 

Overhead

Overhead costs are those costs that cannot be job-costed. Sage Master 
Builder supports direct allocation of a wide range of costs to jobs. A 
great many costs that once required an additional journal entry to allocate 
to jobs can be added as labor burden rates within the payroll system. 
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These can include items such as vacation accrual or small tool expense. 
The daily field reports make it easy to capture job-specific equipment 
use.

A goal for many Sage Master Builder customers is to move all variable 
overhead to specific job costs. For developing estimates and budgets, 
specific overhead rates can be set by bid item, by cost type, and by direct 
assignment in takeoffs; this capability is only available if you have pur-
chased the Estimating add-on module.

Cost Type

Cost types allow you to arrange costs into categories. Each cost code acts 
as a controlling account for the nine cost types. Cost types will be dis-
played on grids throughout the system. Five cost types are defined by the 
system: material, labor, equipment, subcontract, and other. 

Cost codes are key to accurate budget reports. You can set up Sage Mas-
ter Builder to provide budget verification. The program then compares 
the cost codes in the timecard against the cost codes in the budgets. 
When you save the record, the program notifies you if a line item does 
not appear in the budget of a job.

Division (Cost Code)

Divisions allow you to group cost codes. Because Sage Master Builder 
uses divisions to subtotal costs for cost-based reports, many contractors 
create divisions based on the Construction Specifications Institute (CSI) 
structure. You do not, however, have to rely on the CSI structure for divi-
sions and can create your own.

Phase

Using phases in a job affects all its aspects, such as job schedules, the job 
budget, all document control, purchase orders, subcontracts, change 
orders, proposals, project management reports and analysis, job costs, 
change orders, payables, and billing. Phases organize jobs and can repre-
sent different sections of a job, such as different buildings or lots. You 
can also use phases to distinguish different types of work, such as change 
orders or site work. Using phases does not restrict which billing methods 
you can use; in fact, you can use them with time and materials billing or 
change orders.
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Project phases are defined in accounts receivable when you set up jobs, 
but then flow through Sage Master Builder.

Budget - Job

A budget represents a summary of the expected hard costs detailed in a 
takeoff and provides the basis for all budgeted versus actual cost, hour, or 
unit comparisons. In addition, you can use the budget as the basis for the 
proposal you provide the client.

The costs for a budget are categorized by cost code, and each cost code is 
further divided into cost types. Furthermore, you can include the hours 
necessary to complete the work for each cost code. For work performed 
on a unit basis, include the quantity of units to be performed for each cost 
code; the program automatically computes the cost per unit.

There are several ways to create a budget: you can export the data from a 
takeoff, import a file, or create a budget manually. Once the budget is 
completed, you can set the original budget. If at any point the budget is 
changed, you can compare it to the original.

If it becomes necessary to adjust the costs in a budget, enter the changes 
by issuing change orders instead of changing the original budget. Change 
orders allow you to alter the budgeted costs independent from the budget 
itself.
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Underlying Accounting-related Concepts

About underlying accounting-related concepts

You need to understand the accounting related topics below before set-
ting up any component of Sage Master Builder. A clear understanding of 
these topics will ensure that you set up a general ledger that will work for 
your business. These topics will also give you insight into some of the 
operational processes that are part of Sage Master Builder.

Chart of Accounts

Sage Master Builder supports an integrated chart of accounts that func-
tions across all modules of the system.

One of the first tasks when creating a new company in Sage Master 
Builder is to set up the general ledger structure. When you select the pre-
built chart of accounts, the program automatically sets up the account 
ranges, controlling account numbers, posting account numbers, and then 
creates the ledger accounts. You can then modify the ledger setup to meet 
your particular needs. However, you may need to edit the ledger accounts 
to match any changes made in 1-8 General Ledger Setup.

You can also set up the general ledger manually. If you choose to enter 
the account ranges, controlling accounts, and posting accounts manually, 
the program will not create the ledger accounts. You will then need to 
create each ledger account in the Ledger Accounts window.

If you are setting up a completely customized chart of accounts, you 
should work with a business partner.

Department

Departments help organize income and expense data and provide a 
means to evaluate the profit and loss for a company by functional unit or 
profit center. A single controlling account uses a set of subsidiary 
accounts tailored to the controlling account. In contrast, income and 
expense controlling accounts share the same set of departments, and each 
controlling account that uses departments has the same set of subsidiary 
accounts.

You can use departments in a variety of ways. Some companies have 
separate divisions, which use the departments to track the individual 
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income and expense for each division. Others use departments to track 
types of jobs such as residential or commercial, new or remodel, or other 
combinations. Still other companies use departments to track perfor-
mance of salespersons or project managers for bonuses. When you oper-
ate in multiple states, you can create income statements by state using 
departments.

Controlling Account

A controlling account is a ledger account in the general ledger that sum-
marizes the balances for a group of similar subsidiary accounts.

With specific, dedicated controlling accounts, the program uses the 
accounts you designate to automatically post certain transactions to the 
correct ledger accounts. For instance, when you post a receivable 
invoice, you do not need to supply the accounts receivable ledger 
account. After posting a transaction to the general ledger, the program 
locks the account numbers for the accounts under Controlling Accounts. 
The account numbers are locked and unavailable for editing.

You can change the account numbers on the Receivables, Payables, 
Equipment, and Inventory tabs regardless whether you have posted 
transactions. If you change the account number on the Receivables, Pay-
ables, or Equipment tabs, you have to move the balances to the new 
account through a journal transaction.

Controlling accounts are a good way to ensure that your data is properly 
entered into Sage Master Builder.

Subaccount

Using subaccounts (subsidiary accounts), you can arrange financial 
information into related categories under a single ledger account, provid-
ing quick access to specific information. A ledger account that uses sub-
sidiary accounts is known as the controlling account. Primarily asset and 
liability accounts use subsidiary accounts, although you can also use sub-
sidiary accounts with income and expense accounts.

Sage Master Builder automatically sets up subsidiary accounts for dedi-
cated accounts, such as accounts receivable, accounts payable, and ser-
vice receivables using the job, vendor, and client numbers as the 
subsidiary account numbers. Sage Master Builder does not, however, 
provide access to these subsidiary accounts through the Ledger 
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Accounts window because you can view the subsidiary account balances 
from the Job, Vendor, and Client windows.

Closing the books

Closing the payroll and/or general ledger accounting is almost always a 
hectic time. It’s best to schedule enough time for learning about or 
refreshing your knowledge about the closing process, when planning to 
close the books.

We recommend that you run an audit and close your books monthly. This 
helps to keep your ledgers current, accurate, and ready for year-end 
close. Before you begin the year-end procedures we recommend you run 
an audit several days before the scheduled year-end closing. This should 
provide ample time to resolve any errors that could exist and still meet 
your scheduled closing date. After resolving the audit errors but before 
closing the books, make at least two backups of your data. These 
backups are your permanent records.

The time it will take you to close your books depends on many factors, 
but especially on the size of your company and the state of your 
accounting. If the following conditions are true: 

• you have already prepared backups,

• you have been keeping up with accounting period audits,

• you only have repairable period audit errors,

• and you do not have very many employees, 

then you may be able to close your books in a few hours to half a day. 
Obviously, larger companies with many employees and companies with 
audit errors may spend a day or two on closing the books. 

There are three possible ways to close the books. Sage Master Builder 
provides checklists for each closing method:

• Close the payroll at calendar year-end (closes on 12/31)

• Close the general ledger accounting at fiscal year-end

• Close the fiscal year and the calendar year at the same time (closes 
on 12/31)
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Company archive

Over the course of a year, the accounting and payroll databases grow as 
you enter records. Like a manual accounting system where you might 
move the previous year’s records to storage boxes or a storage facility, 
you can move Sage Master Builder records to an archive file.

When you close your books, it is important that you create a mirror 
image of your data for tax reporting purposes. This is referred to as your 
company archive or archive directory. It is a duplicate copy of your 
existing company data up to the point when you create it. 

The company archive resides on the same drive as the active company. 
With an archive of the previous accounting year on the same drive as the 
active company, you can simultaneously post to period 0 in the active 
company and period 12 in the company archive.

Accounting Period 0 (Zero)

When you want to enter the startup balances and invoices for a new com-
pany or when you want to adjust the beginning balances for a company, 
post to period zero. Period zero is not part of the fiscal year; therefore, 
Sage Master Builder does not include transactions posted to period zero 
in any year-to-date reports.

When you post to the asset or liability accounts in period zero, the pro-
gram adjusts the beginning balances. If you post to income or expense 
accounts in period zero, the program adjusts the beginning balance of the 
Retained Earning ledger account because income and expense accounts 
do not have beginning balances.

Changing posting periods

Use the Change Period window to change the default current posting 
period for the entire program. The window allows you to change to any 
posting period within the current fiscal year. You can also choose to set 
the posting period to period 0 (00-Prior Year). 

When you advance to the next posting period or a future posting period, 
for example from period 1 to period 2 or 2 to 9, the program performs an 
audit automatically. The audit results are logged in the Audit History 
window. After the audit has been completed, you click the button to 
change the period. 
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To change the posting period, under Period Selection, type a period 
number or click the arrow button to open the Posting Period window 
from which you can select a posting period. 
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Additional Details
This chapter provides information about the following:

General Operational Features

Accounting Details

Analysis Details

Accounts Payable Details

Accounts Receivable Details

Document Control Details

Equipment Management Details

Estimating Details

Inventory Details

Payroll Details

Production and Project Management Details

Reporting Details

Scheduling Details

Service Receivables Details
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About Additional Details

These topics are organized around specific Sage Master Builder func-
tions. As you plan implementation of a particular area, these concepts 
will point you toward key points you need to consider to ensure a suc-
cessful startup.
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General Operational Features

Sample Company

The Sample Company provides the means for viewing and working with 
sample data in Sage Master Builder windows. There are sample 
accounts, sample employees, sample takeoffs, and much more. By 
viewing and working with this sample data, you can gain an 
understanding of how different windows interact with the sample data 
when managing a construction business with Sage Master Builder. 

Sage Master Builder master trainers use the Sample Company exten-
sively during Sage Master Builder training classes. We highly recom-
mend that you load the Sample Company during your initial installation. 

You can log on to the Sample Company using “Supervisor” as the user 
name. You do not need a password. 

The Sample Company:

• Allows you a safe way to try out new functions as you learn them.

• Is used in many online and recorded classes.

• Provides samples of many Sage Master Builder forms that are all 
filled in. This makes it easy to understand many concepts.

• Provides starter lists for many values you'll need to set up: cost 
codes, cost types, tasks, client status, client type, employee positions, 
paygroups, etc.

• Provides you with live data to investigate the content of Sage Master 
Builder reports.

• Takes very little space on your hard disk drive.

Archive Company

Over the course of a year, the accounting and payroll databases grow as 
you enter records. Like a manual accounting system where you might 
move the previous year’s records to storage boxes or a storage facility, 
you can move Sage Master Builder records to an archive file.

When you close your books, it is important that you create a mirror 
image of your data for tax reporting purposes. This is referred to as your 
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company archive or archive directory. It is a duplicate copy of your exist-
ing company data up to the point when you create it. 

The company archive resides on the same drive as the active company. 
With an archive of the previous accounting year on the same drive as the 
active company, you can simultaneously post to period 0 in the active 
company and period 12 in the company archive.

You can only make a company archive during the process of closing the 
books at the year-end. When you archive records for a company, Sage 
Master Builder copies all the data from the active company to a separate 
file. Sage Master Builder then removes the records you have selected 
from the active company to prepare it for the new fiscal or payroll year.

Company Information Record

The company information record of Sage Master Builder stores key 
information about a specific company which you are managing with 
Sage Master Builder.

You keep track of such information as:

• Name

• Address

• Phone and fax numbers

• License and tax IDs

• Direct deposit

• email server setup

• Fax setup

See the Sage Master Builder Help for a full list. These are all key items 
to set up since they may drive other parts of your system.

Security features of Sage Master Builder

Sage Master Builder provides a variety of security features that allow 
you to restrict access to data in each company. You can do the following:

• Create a list of users and passwords for each company. The list of 
user names and passwords allows you to restrict access to individual 
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companies. Moreover, if a user does not have access to a company, 
that user does not have access to the archive of that company.

• Create groups of users. Security groups provide a way to collect 
users together in meaningful sets such as project managers, payables 
clerks, or payroll clerks. With groups established, you can then 
assign each user to up to five security groups.

• Control the admission of users to windows through security groups. 
Moreover, you can assign access rights to each security group.

• Control items within windows such as text boxes, lists, check boxes, 
and grid columns. By limiting what information a security group can 
enter or view in a window, you also restrict access to that same 
information in queries and reports. For example, you might not want 
to allow the payroll clerks security group access to salaries and wage 
rates in the employee files. The payroll clerks will not be able to 
view salaries and wage rates in the employee files, or while entering 
timecards, or by running any payroll reports.

Each company in Sage Master Builder can use different user names, 
passwords, security groups, and access rights. You only have to set up 
security groups and access rights one time for each company. As you add 
or remove users from the User List, you can simply assign or reassign 
users to the proper security groups.

Security Groups

In Sage Master Builder, you can set up security groups for your 
company’s employees. Security groups let you control users’ ability to 
open windows as well as perform specific actions within a window.

When you set up user groups, you type a group number and group name. 
Then you determine whether or not that group will have rights to save, 
delete, and void records, as well as to change the accounting period and 
print checks. You may use the notes column to add any pertinent 
information about each group.

IMPORTANT
Many actions in Sage Master Builder can only be performed 
when logged on as the “supervisor” user. When setting up secu-
rity, it is critical that you add a password for the user name 
“supervisor.” 
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While you might create security groups for specific employees, it is a 
good idea to build each security group for the tasks performed by the 
employee. This allows you to add or remove employees from security 
groups easily, rather than having to build a new security groups for each 
new employee.

As a company’s size increases, the need for additional security groups 
increases. For example, a large company has an office staff that includes 
several accounts payable clerks, an accounts receivables clerk, a payroll 
clerk, a controller, project managers, and estimators. In this company, six 
different security groups are set up to accommodate the specific needs of 
the employees engaged in six different task areas.

In addition to creating task-oriented security groups, it is a good idea to 
create one security group with full access to the entire program. This 
allows owners or managers to log in with full access, but prevents 
unauthorized access to program features that only a user logged in as 
supervisor can use.

It is important to consider the scope of tasks performed by users as well 
as the number of users that access Sage Master Builder. Before designing 
security groups, examine which users need access to specific windows in 
Sage Master Builder. After you set up the security groups, you can then 
set up window and menu-level security.

For example, a small company has three clerks: a general accounting 
clerk, an accounts payable and accounts receivable clerk, and a payroll 
clerk. For this company, it is only necessary to create three security 
groups. The first group, entitled “Payroll Clerk,” only provides access to 
payroll operations. The second group, entitled “A/P A/R Clerk,” 
provides access to accounts payable and accounts receivable operations. 
The third group, entitled “General Ledger Clerk,” provides access to 
general ledger operations not covered by accounts payable and accounts 
receivable.

Consider the following before setting up security groups:

• Do you need to create separate security groups for employees who 
perform specific tasks? For example, does your company have a 
payables clerk who only enters payables data?
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• Do you need to create separate security groups for accounts payable, 
accounts receivable, and payroll supervisors, or can you just create 
one group for the supervisors?

• Do estimators perform different tasks than project managers?

• Do you need to provide differing levels of access to owners, 
controllers, or managers?

Are you going to use the Sage Master Builder API to integrate with other 
programs? If so, create a security group named “API” with a group num-
ber such as 51.

About the supervisor user

When you log on to Sage Master Builder as “supervisor,” you have 
access rights to the entire Sage Master Builder application. 

Following is a list of actions you can only perform when logged on to 
Sage Master Builder as supervisor:

• Create security groups in 7-3-1 Security Groups. 

• Grant access rights to security groups for windows and items within 
windows such as text boxes, lists, and grid columns in 7-3-1 
Security Groups. 

• Use the F7 key to display the Field Properties dialog box to set the 
individual security properties for a text box, list, check box, or grid 
column, as well as set security for certain menu commands from the 
main menus. You can also customize the window, set defaults in 
specific fields, and set system user prompts. 

• Create user names and passwords, and assign user names to security 
groups in 7-3-1 User List. 

• Create new companies in 7-1 Create New Company. 

• Make and save changes to the General Ledger in 1-8 General 
Ledger Setup. 

Important: 
To maintain security, we strongly recommend that you set up a 
password for the supervisor user. Be sure to write it down and 
keep it in a safe place.
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• Close the accounting at the fiscal year-end in 1-6 Change Period/
Close Year. 

• Close payroll at the calendar year-end in 5-3-8 Close Payroll Year. 

• Restrict posting to specific accounting posting periods, for example, 
4-2 Payable Invoices/Credits and other windows. 

Field Properties

Field properties allow the supervisor user to extend security wherever it 
is needed. The supervisor can assign field properties for every field on 
every entry window and grid in the program. Items defined include 
defaults, custom field names, field processing during entry, and which 
users have access the window and fields on the windows.

User Name

You can set up a list of user names for each company to control access to 
each company you set up in Sage Master Builder. By setting up security 
groups and assigning the groups to user names, you can further limit 
access to certain windows, and text boxes, lists, and columns within win-
dows.

Because Sage Master Builder determines access through the user names, 
a user can log on to the program from any workstation in a network envi-
ronment.

User-defined Fields

User-defined fields are available on many key forms in Sage Master 
Builder. They offer another way for you to customize Sage Master 
Builder for your business. You can determine the names and how these 
fields behave and then use them in your own reports.

See also Field Properties.

Export

Exporting is a Sage Master Builder concept for moving data from one 
area of the program to another. This provides powerful workflow fea-
tures to automate key tasks. Export capabilities are found throughout the 
program but key ones support development of purchase orders, bids, pro-
posals, change orders, subcontracts, and budgets from takeoffs.
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Files can be exported as templates to be used in other jobs or in other 
Sage Master Builder managed companies. This saves you valuable time 
as you copy key components from job to job and also provides consis-
tency for job analysis.

Exporting can also be done from many grids, and creates standard .csv 
files. You can use Export to Excel from almost all reports.

These capabilities will allow you to take your Sage Master Builder infor-
mation and feed other custom applications your company may use.

Import

There are many different import capabilities in Sage Master Builder. 
These capabilities allow you to bring data into Sage Master Builder from 
different outside sources. Imports also allow you to use saved files and 
templates to get a fast start on new jobs.

Basic capabilities for import are provided in virtually every grid via stan-
dard cut and paste (See also “Grids”). Specialized internal imports sup-
port such features for re-use of budgets, proposals and estimates, among 
others, for use in new jobs.

Specialized external imports support such features as price updating 
from parts databases. Finally, specialized programs from third-party ven-
dors provide complete ways to import a variety of specialized data, from 
time sheets to estimating data and beyond. Click this link for more infor-
mation about using the Sage Master Builder API. 

Defaults

You can customize many different aspects of Sage Master Builder. For 
instance, by using security groups, you can grant or restrict access to spe-
cific windows. Within a window, you can customize text boxes, lists, 
check boxes, and columns to increase data entry speed and accuracy. 
Within each window, you can set up default information, require entries, 
skip entries, or even limit access to specific security groups.

For instance, in the Checks and Bank Charges window set the default 
ledger account number for your checking account in the Account Num-
ber box. When you open the window, the program automatically inserts 
the account number.
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You can save time and effort by setting up your preferences for report 
types, form designs, selection criteria, and options in the Report Printing 
window. You can also set preferences for printers, page ranges, page ori-
entation, and number of copies to print. When you save the defaults, the 
program assigns them to the person currently logged on to the program 
by referencing the person’s user name.

You can copy most defaults (except security groups) from existing users 
to new users to speed setup of new employees.

Template

Sage Master Builder templates can provide the starting point for just 
about any business process. A template can include any information you 
want to provide, such as dates, descriptions, or other important informa-
tion. You can create a template from scratch, or modify an existing 
record and save it as a template. Unlike a record, you do not have to com-
plete required fields to create a template. Many windows throughout the 
program let you create templates.

Suppose that you are building homes in a residential subdivision. The 
budget and proposal for the base design are established and do not vary. 
Using templates in the change orders window, you can create a different 
template for each upgrade. When you are informed which upgrades the 
home buyer wants, you can quickly load the corresponding templates to 
create the necessary change orders.

You can either use an existing record as the basis for creating the tem-
plate, or you can build the template from scratch.

Templates are a key tool for customizing Sage Master Builder and also 
provide ways to standardize data input so you can manage your com-
pany. Consult with your business partner to analyze where templates 
might help you.

Notes

Notes are a feature throughout Sage Master Builder. You can keep notes 
with nearly every type of record, which can prove helpful when review-
ing data later. You save notes with individual records, as well as with 
individual rows in a grid. Notes can be reviewed at any time and can be a 
valuable part of many printed reports. They are the place to put further 
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details and specifications to make sure all parties understand a decision 
or need.

Notes can be exported from estimates to provide details of specifications 
that can support all areas of production. 

Grids

Grids are a powerful feature of nearly all Sage Master Builder functions. 
Essentially, grids display the detail information of a transaction, estimate, 
budget, change order, or any item which has a header to details relation-
ship.

All users can customize grids to display just the information they need. 
You can modify and save the grid defaults by user.

Grids also provide a handy way to import and export information from 
and to external programs with simple cut-and-paste capabilities.

Within Estimating, takeoff grid files provide specialized functionality for 
rapidly building estimates using a library of already developed grids.

You need to study each grid in the detail screens before you implement 
that section of Sage Master Builder.

Lookup Windows

Lookup windows help you locate data. Suppose you are entering a pay-
able invoice, but do not remember the vendor number. You can open a 
Lookup window, find the vendor, and then insert the vendor number in 
the appropriate box.

Lookup windows are used throughout Sage Master Builder. You can sort 
items in a lookup window, set a default sort order, and select items with a 
click.

Learning to use lookup windows is part of the mechanics that will make 
your Sage Master Builder experience successful.

Quick Lists

With quick lists, you can create lists of transaction descriptions, names, 
states, and ZIP Codes, then quickly retrieve the information for entry. 
Each list is specific to its associated text box and window.
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This is a very handy feature for ensuring that your data is consistent. In 
conjunction with setting Field Properties and locking the quick list, you 
can guarantee that data will be entered with the values you need.

Attachments

Attachments provide functionality to attach files and/or Web links to 
selected records in Sage Master Builder. There are two methods for 
attaching files and links. You can add them individually using the 
Attachments window (Edit > Attachments), or you can simply drag 
and drop files and/or Web links onto a Sage Master Builder window that 
accepts attachments. 

The Sage Master Builder windows that accept attachments are payable 
invoices, requests for proposal, progress bills, change orders, purchase 
orders, and jobs. 

Here are a few examples of how you might use attachments: 

• After receiving a hard copy document that you would like to attach 
to a payable invoice record, you scan the document into your com-
puter to create a file, then attach the file to the payable invoice 
record. 

• You have several digital photos of work being done by a 
subcontractor on a remodel job. You can transfer these files to your 
computer, and then attach them to a subcontract record. 

• After sending an RFP to an architect who has a website, you want to 
attach the architect's website URL to the RFP record. From the open 
site in your browser, you drag and drop the link from the browser's 
Address box onto a request for proposal record. 
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Accounting Details

General Contractor (Accounting)

General contractors are provided with specific general ledger chart of 
accounts they can select during set up. They also have a starting set of 
cost codes that may suit their needs. Functionally, Sage Master Builder 
provides a range of management tools for the general contractor to man-
age scheduling, purchasing, and subcontractors.

When you select the pre-built chart of accounts, Sage Master Builder 
automatically sets up the account ranges, controlling account numbers, 
posting account numbers, and then creates the ledger accounts. If you use 
payroll and use the command to Create Standard Calculations, then the 
payroll calculations are automatically linked to the proper general ledger 
accounts.

General contractors can also copy and customize the Sample Company 
Cost Code List.

Home Builder (Accounting)

Home builder capabilities are built right into Sage Master Builder. Indus-
try standard general ledger chart of accounts and cost codes are available 
when you create new companies. Additional features include “starter” 
task lists plus some standard parts and assemblies.

Sage Master Builder also provides a special selection of project manage-
ment reports just for home builders. You may also find that the work in 
progress (WIP) features are useful.

WIP (Accounting)

Many contractors refer to any project in the process of completion as a 
work in progress. You can print a WIP report for any job to determine the 
WIP adjustment for “percentage-complete” accounting. Using this 
adjustment, you can post a transaction that allows you to compare the 
revenue generated during a given fiscal period to the expenses incurred 
during the same fiscal period.

WIP also refers to a method of accounting used with speculative 
projects. Because the contractor owns the project, the contractor must 
declare improvements to the property as an asset. Only after the contrac-
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tor sells the property, does he or she then declare the revenue and 
expense.

Methods for using WIP adjustments and WIP for speculative projects are 
detailed in Sage Master Builder in-product Help and in the User Guide. 
You should review this information with your accountant or business 
partner before you start using WIP features. 

Remodeler (Accounting)

Sage Master Builder offers specialized support for remodelers in two 
areas.

General Ledger - When you select the Remodeler Accounts, Sage 
Master Builder automatically sets up the account ranges, controlling 
account numbers, and posting account numbers, then creates the ledger 
accounts. You can then modify the ledger setup to meet your particular 
needs. This accounting structure has been put in place for the needs of 
remodelers.

Estimating Data, Cost Codes, and Tasks - Sage Master Builder pro-
vides remodelers with starter data, giving you a head start on setting up 
your accounting structures.

Estimating data can be used as a starting point for your takeoffs, saving 
you time when creating estimates. This includes a specialized chart of 
accounts, cost codes, tasks and the following estimating data:

• Parts

• Assemblies

• Part/Assembly classes

• Takeoff grid files

Subcontractor (Accounting)

Subcontractors are provided with specific general ledger chart of 
accounts they can select during set up. They also have a starting set of 
cost codes that may suit their needs.

Sage Master Builder provides functionality needed by the Subcontractor 
such as management for change orders, capabilities for importing from 
specialized estimating systems and management of the pre-lien and 
release process.
48



 Additional Details
Current Period default (Accounting)

Sage Master Builder sets an accounting period default depending upon 
your fiscal year-end date and the current posting period date established 
during your general ledger setup. You then control the movement of your 
accounting to the next period using the windows under 1-6 Change 
Period/Close Year.

You can have Sage Master Builder verify the date of transactions versus 
this default. You can also change the default period while you are enter-
ing a specific set of transactions. 

Posting period (Accounting)

Using 1-6 Change Period/Close Year, you can set the posting period to 
any period from 0 (prior year) to 12. When you advance the posting 
period, the program performs an audit automatically, and the audit results 
are logged. 

As you enter individual transactions, Sage Master Builder will assign 
them to the current accounting period, but the program can be set to 
check the transaction date and warn you of an error in posting an item.

Audit (Accounting)

When you audit the books of a company, Sage Master Builder verifies 
that the accounts are balanced and that valid transactions support the 
balances. 

In Sage Master Builder, you can audit the books at any time to help 
maintain your ledger balances. When you audit the books, the program 
does not make any changes, but it does log any errors using the Audit 
History function. 

When you advance to a new period in the future, the program audits the 
books automatically as part of the process to change the default posting 
period. 

When you start a new company or suspect data corruption, it is a good 
idea to audit the books and recalculate balances. If unbalanced data 
exists, the program alerts you so that you can correct the errors as early 
as possible. 
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Fiscal Year (Accounting)

Sage Master Builder's fiscal year is driven by the year-end day you select 
when you complete your general ledger setup. Once you set this date, 
you do not have to change it annually. Sage Master Builder will do so as 
part of the fiscal year-end close.

See also “Fiscal year-end close (Accounting)”

Prior Year (Accounting)

The year-end close process creates a prior year company which Sage 
Master Builder calls the archive company.

For ledger accounts, Sage Master Builder rolls over the ending balances 
for permanent accounts to become the beginning balances for the new 
fiscal year. All period balances roll over becoming balances in the Last 
Year column. All temporary accounts, such as revenue and expense, start 
the year with zero balances.

When closing the books, the program only deletes “cleared” prior-year 
check records and the remaining prior-year checks are appended to the 
prior-year check database (DBF) file. This allows you to reference prior 
year checks from more than one previous year. 

See also “Archive Company”

Fiscal year-end close (Accounting)

Sage Master Builder requires you to close your books at the end of your 
accounting year. At the end of fiscal period 12, you can close the books 
for the year. Before closing, be sure to create a backup of your data. The 
backup represents a permanent copy of your financial data. 

During the close at the fiscal year-end, the program audits the accounting 
to verify that valid, balanced transactions support the account balances. 
When no errors are present, the program then removes transactions for 
the closing year and prepares the balances for the new fiscal year. Sage 
Master Builder can create a copy of all detail transaction data in the 
archive company.

Calendar Year-end (Accounting)

Calendar year-end can be combined with fiscal year-end for a complete 
closing of your Sage Master Builder general ledger. For calendar year-
50



 Additional Details
end, you may wish to just close the payroll and reset vendor 1099 bal-
ances. You can then send W-2s and 1099s from your archive company.

Payroll details are best viewed in the Help topic, “About closing the 
payroll.” Vendor 1099 details are best viewed in the Help topic, “About 
Federal 1099 forms.”

Journal transaction (Accounting)

Use the journal transactions capability to review most general accounting 
records. You can also use journal transaction capability to enter adjusting 
journal entries.

You cannot, however, enter transactions or adjust journal entries for the 
following

• Accounts payable

• Accounts receivable

• Service receivables

• Inventory

• Payroll

These accounts are posted by their own subsystems.

Profit (Accounting)

Sage Master Builder has a multi-step income statement for developing 
company profit. Gross profit is developed, and then overhead and admin-
istration are deducted for earnings before income tax. Finally, after-tax 
items are deducted to reach net profit.
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Analysis Details

Sample Reports (Analysis)

Sage Master Builder provides representative samples of most reports that 
are available. These samples are not generated from the sample data but 
are images for you to view. Viewing these provides a sense of the report 
content without having to learn the specific selection criteria to view 
valid data.

Take some time to review the reports available to you under each menu 
item as you start your implementation. For example, under menu item 3-
Accounts Receivable, you have 3-1 Receivable Reports. 

Over/Under billing (Analysis)

The Over/Under Billing report is an analysis tool of Sage Master 
Builder to help you keep your jobs profitable. This report combines cost, 
budget, contract, and billed information into one key summary that high-
lights jobs where your costs may be running away or where a key billing 
has not been done. This reporting is also referred to as a WIP report in 
the construction industry.

Profit (Analysis)

Sage Master Builder provides many reports for analyzing job profitabil-
ity. These reports are found under menu 3-Project Management. You 
can start at a high level to identify possible problem jobs by comparing 
budgets to costs line by line. Then you can drill down into the records to 
determine where the problems are in detail. 
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Accounts Payable Details

Invoice (Accounts Payable)

The payable invoices/credit capability of Sage Master Builder lets you 
quickly enter transactions that affect vendor accounts. You can create 
invoices or credit invoices, track and release retention, or view a history 
of payments for a specific invoice.

A number of other features enhance record entry. When you select the 
Manufacturer Details command, Sage Master Builder includes the 
manufacturer's name and part number in the description of each part. To 
help manage inventory, select the Allow Freight/Variance command to 
post variances in material or freight costs. When you have finished enter-
ing records, use the batch list to verify the invoice totals against the 
actual invoice totals.

Vendor (Accounts Payable)

Vendor records provide quick access to vendor information for payable 
invoices, 1099 balances, ordering materials, and subcontract manage-
ment. It is a good idea to create a vendor record for each business that 
sends invoices to your company. In addition, you should create records 
for businesses to which you owe money or make regular payments to, 
such as vendors, suppliers, subcontractors, architects, engineers, and 
lenders.

Inside vendor management, you can review vendor-related information 
such as subcontracts, purchase orders, and invoices. You can also record 
any additional certificates a vendor is required to supply.

Vendor types (Accounts Payable)

You can use vendor types to group or categorize vendors. Types give you 
the ability to select specific vendors when printing RFPs, vendor lists, or 
other vendor-related documents.

The Sage Master Builder Sample Company comes with a large selection 
of vendor types for you to consider and use.

Although you can change vendor types at any time, it’s best to set stan-
dards for vendor types before you start entering vendors. This way your 
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vendors will be all set up to take advantage of Sage Master Builder's 
effort-saving features

Retention (Accounts Payable)

Many job subcontracts include retention. When you create a payable 
invoice, Sage Master Builder withholds retention at the rate specified in 
the subcontract record. If you do not indicate a retention rate in the sub-
contract record, you can withhold a flat amount on each individual 
invoice.

Posting a payable invoice declares the entire amount of the invoice as an 
expense. A percentage of the gross amount, however, is withheld as 
retention, so the vendor is actually paid for the net amount (gross invoice 
amount - retention = net amount due). Therefore, retention is already 
declared as an expense but is not yet due. Consequently, Sage Master 
Builder considers retention in the invoice aging to be current.

When you are ready to pay the subcontractor for retention, it is not nec-
essary to create a new invoice. You can release retention on each invoice 
individually, or you can release the retention for the entire subcontract at 
one time.
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Accounts Receivable Details

Client (Accounts Receivable)

You can store information about past, current, and future clients as well 
as manage the sales process and track client-related issues.

Most contractors will set up a client and then set up jobs tied to that cli-
ent. Some service contractors may just set up jobs directly.

To help manage sales, you can keep track of referrals, appointments, call 
back dates, and even when you last mailed a brochure to the client. In 
addition, you can set up customized lists to provide information about 
the lead source, region, company size, and to which mailing list they 
have been assigned.

Using information from the client database, you can create a wide variety 
of client-related documents and reports.

Client Status (Accounts Receivable)

The Client Status field is completely customizable for your specific 
needs.

Using client status provides you with information such as sales cycles, 
credit limits, or other client characteristics. You can even set up the status 
criteria to separate the clients in to client prospects, current clients, and 
past clients.

Client Type (Accounts Receivable)

The Client Type field allows you to categorize clients. A subdivision 
developer, for instance, can use the client types to list the subdivisions, or 
the release of homes in subdivisions or to track the interests of prospec-
tive home buyers. For some companies such as service/repair contrac-
tors, the geographic area is more important because all the clients are 
homeowners or commercial businesses.

Although client type is an optional field to use in identifying your clients, 
you should think through your needs before entering clients. It is much 
easier to categorize your clients as you enter them rather than going back 
later.
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Job Number (Accounts Receivable)

Job number is a key for locating job cost records, selecting invoices for 
payment, and a finding a variety of reports. If your job numbering system 
is set up to reflect specific job groupings, you can use the numbering 
system for selecting jobs. 

When you are setting up a job numbering system, it is important to create 
one that fits your company’s work. Companies that only do a few jobs a 
year may not need job numbers with four or five digits, whereas larger 
companies might need more digits. 

Job Type (Accounts Receivable)

You can classify jobs that your company performs in any fashion that 
you choose. You may identify jobs by contract, work performed, or any 
other means.

Once you have identified the jobs, you can create reports to see the per-
formance of different job types. This may be an alternative to creating 
artificial departments to do the same thing.

Contracts (Accounts Receivable)

Contracts are an essential part of jobs and accounts receivable. Sage 
Master Builder can use your contract terms, dates and amounts to auto-
mate many types of billing and follow-up activities.

Contract summary data for a job can show you:

• Original contract amount

• Changes to date

• New contract amount

• Invoiced to date

• Balance on contract

• Open charges

• Balance with tax

• Retained balance

• Net due with tax
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These amounts can drive invoicing and will help you analyze and control 
your jobs.

Contract Amount (Accounts Receivable)

The current contract amount is available on the 3-5 Jobs (Accounts 
Receivable) window. You can find a further breakdown of this amount 
on the Contract Summary window. This amount is the starting point for 
some of your billing methods, such as progress billing.

See also “Contracts (Accounts Receivable)”

Invoice (Accounts Receivable)

Sage Master Builder helps you quickly enter receivable invoice or credit 
transactions that affect receivable accounts. You can create invoices or 
credit invoices, track retention, or view a history of payments for a spe-
cific invoice.

You can also create a simple invoice based on the percentage of work 
completed for the contract. This type of billing is suitable for subcontrac-
tors or small projects.

Receivable invoices also provide the ability to enter taxable and non-tax-
able items on an invoice at the same time.

Receivable invoices are only one example from the full range of billing 
capabilities in Sage Master Builder. See the following for more informa-
tion: 

• Progress Billing (Accounts Receivable)
• Time and Materials (T&M) Billing (Accounts Receivable)
• Unitary Billing (Accounts Receivable)

Statement (Accounts Receivable)

A statement summarizes the activity of invoices, payments, credit 
invoices, and retention for a job. It is a good idea to print the statements 
at the end of each month and send them to your clients to keep clients 
informed of the financial activity for their job.

Sage Master Builder supports monthly statements with finance charges 
and also combined and summary statements.
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Retention (Accounts Receivable)

Many job contracts include retention. When you create a receivable 
invoice, Sage Master Builder withholds retention at the rate specified in 
the job file. If you do not set up a default rate in the job file, you can 
withhold a flat amount on each individual invoice.

Posting an invoice declares the gross amount of the invoice as income. 
However, a percentage of the gross amount is withheld as retention, so 
the client is actually billed for the net amount (gross invoice amount - 
retention = net invoice amount). Therefore, retention is already declared 
as income but is not yet due. Consequently, Sage Master Builder does not 
age retention in the invoice aging, and does not apply finance charges to 
it.

When you are ready to bill the client for retention, it is not necessary to 
create a new invoice. The retention has already been declared income, so 
you only need to release the retention that has been withheld. You can 
release retention on each invoice individually, or you can release the 
retention for the entire job at one time. Having released the retention, you 
can then send the client a statement reflecting the amount that is owed to 
your company.

Sage Master Builder retention is somewhat different from some other 
systems in that it is not stored in a separate general ledger account. How-
ever, it is easy to see total outstanding retention in several AR invoice-
aging reports.

Progress Billing (Accounts Receivable)

Progress billing provides a system for creating billings, with each new 
application building on the previous application for a job. Many progress 
bills are printed on American Institute of Architects (AIA) certificates.

For each job, you create a series of applications with each new applica-
tion building on the previously submitted application. Under each job, 
Sage Master Builder assigns each application its own application num-
ber.

You can select several ways to automatically update the cost information 
from the job cost records. When you select the Percent from Costs com-
mand, Sage Master Builder displays the actual job costs and calculates 
the percent of work completed by comparing the job costs against the 
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budget. You can instead select the From Cost Amounts or From Billing 
Amounts command to display only the amounts for each cost code.

You can also update the amount of the change work to the progress bill. 
You can either incorporate the additional charges to the existing cost 
codes or divisions, or include the total amount of the change order as a 
separate line item.

Progress billing calculates and prints on the AIA G702 and G703 forms 
as well as a number of other progress billing formats. Use progress bill-
ing to create percentage-of-completion line item billing. Progress billing 
supports variable rate retention, stored materials, and automatic updating 
from change orders and job costs.

Time and Materials (T&M) Billing (Accounts Receivable)

You can bill clients on a cost-plus basis, which is the cost for time and 
materials plus overhead and profit. Sage Master Builder uses the job cost 
records as the basis for the billing amounts on the time and materials 
(T&M) invoices.

When setting up a job for T&M billing, you can:

• Assign separate overhead and profit markup rates to each cost type.

• Assign a shown markup rate to each cost type.

• Assign a hidden markup rate to each cost type.

• Assign wage rate and equipment rate tables to the job. 

• In addition, you can set a minimum daily charge, which is the mini-
mum number of hours per laborer, or you can set up minimum units 
per piece of equipment to charge.

Unitary Billing (Accounts Receivable)

With certain types of work, it is more difficult to estimate the amount of 
work necessary to complete the job. For example, with grading or exca-
vation work it proves easier for a contractor to bill for the number of 
units of earth moved. Unitary billing provides a system for creating a 
series of unit-based applications, with each new application building on 
the previous application for a job.

Before using unitary billing, you will typically prepare unitary proposals.
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Application (Accounts Receivable)

Applications are generally the starting point for getting approved pay-
ments for a number of different processes. You will create an application 
for payment, get it approved and then submit an invoice.

Applications apply to:

• Progress billing

• Loan draws

• Unitary billing

Sales Tax (Accounts Receivable)

Sage Master Builder supports the complex sales tax structures your busi-
ness may need. Sales tax requirements differ from region to region. In 
one region you might not have to report any sales tax, while in another 
region you might need to report taxes on everything but subcontract 
work. Before setting up the tax districts, consult the local tax agencies to 
determine the correct tax rates.

As you know, most states and many cities impose taxes on sales. The 
seller must add the tax to the selling price and then pay the taxes to the 
government. Certain types of work require contractors to collect and 
remit sales taxes to the appropriate government agency. Tax districts pro-
vide the flexibility necessary to manage, compute, and report the individ-
ual sales taxes levied by state, county, and municipal governments.

When you create an invoice, Sage Master Builder determines the sales 
taxes from the indicated tax district. A tax district is comprised of a 
group of tax entities to which you report the taxes collected within that 
particular region. Before you can create a tax district, you must create the 
tax entities. Your tax entity calculations can also compute discretionary 
surtaxes.

Tax District (Accounts Receivable)

Tax districts provide you with the flexibility to manage, compute, and 
report the individual sales taxes levied by state, county, and municipal 
governments.

When you create an invoice, Sage Master Builder determines the sales 
taxes from the indicated tax district. A tax district is comprised of a 
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group of tax entities to which you report the taxes collected within that 
particular region. Before you can create a tax district, you must create the 
tax entities.

Tax Entity (Accounts Receivable)

Tax entities are the building blocks of tax districts. Up to five different 
entities can be combined to make one district. This capability provides 
the flexibility to meet a wide range of sales tax needs.

Tax entities support limits for the amount of tax collected. These limits 
can be based on invoice, job, service contract, or service location.
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Document Control Details

Daily Field Report (Document Control)

You can track the conditions and events that occur at the job site on a 
daily basis using the 6-11-6 Daily Field Reports. You can keep track of 
the employees and subcontractors working on the job, what equipment 
was used, and how many units of work were completed. In addition, you 
can track incidents, meetings, and field orders. Relevant portions of this 
data will be fed into payroll, and then to job costing.

Submittal (Document Control)

You provide submittals with all material samples supplied to the general 
contractor, client, or architect. The submittal lists each sample you are 
providing for review.

Submittals provide for not only tracking the item, but identifying the 
action required and due date.
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Equipment Management Details

Equipment Cost Recovery (Equipment)

You can remove the guesswork associated with recovering equipment 
costs. In the 8-Equipment Management, you can provide the cost to 
own and operate the equipment for a resource consumption period as 
well as the estimated use for the resource consumption period. You can 
then compute an estimated per-unit rate to apply to jobs.

Through the cost recovery rate, you post the costs for owning and operat-
ing equipment to the job. The accounting transaction posts a debit to the 
job expenses account in the direct expense range, and a credit to the 
equipment revenue contract account in the equipment/shop expense 
range. The transaction increases direct expenses and reduces equipment 
expenses, resulting in a more realistic view of job profits. At the same 
time, the program creates a job cost record and an equipment revenue 
record.

To determine the cost recovery rate, project the use and costs that you 
can expect based on records from previous years. Do not include the cost 
of labor in the operational costs because job costs created in Sage Master 
Builder include the equipment operator's time. It is a good idea to review 
the cost recovery rate every year and make adjustments. If you discover 
that the equipment use is considerably higher or lower than expected, 
you can make the suitable adjustments.

Shop (Equipment)

Sage Master Builder handles tracking your equipment and assigning the 
cost of use to jobs where possible.

When you post transactions to the “equipment/shop expense” range of 
accounts, Sage Master Builder displays the Journal Transaction Equip-
ment Cost window regarding cost distribution. In the Equipment Cost 
window, you can break apart costs to create individual line entries that 
reference equipment, cost codes, and cost types.

Sage Master Builder helps you move expenses from the indirect category 
of Shop to direct job-related expenses.
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Estimating Details

Assembly (Estimating)

Assembly estimating is a simple, accurate way to create takeoffs quickly. 
It also streamlines the management of material costs, quotes, and order-
ing because each assembly includes all the necessary parts and labor to 
complete a unit of work.

An actual assembly represents a collection of parts necessary to complete 
a single unit of work. For instance, an interior door assembly can include 
the door, frame, hinges, trim, doorknob, shims, and nails. Some other 
examples of assemblies are kitchen cabinets, linear feet of wall, window 
installation, roof framing, roofing installation, bathtubs, showers, pipe 
runs per foot, and conduit runs per foot.

Note that assemblies are only available in the Estimating add-on module 
or Service Receivables/Inventory add-on module.

Parts (Estimating)

A part is a record of an item that you want to track in the parts database. 
You can manage costs, track part inventories, and even assign an image 
to individual part records. You do not have to limit part records to build-
ing materials; you can even create part records for labor costs. To set up a 
parts database, enter the parts manually or import an existing database.

If you subscribe to a part-pricing service, you can update the prices in the 
parts database as you receive the latest service updates.

Parts are used in estimating, service, and inventory. Parts can be used 
within assemblies for “assembly-based estimating.”

Bid Item (Estimating)

Bid items are a way of breaking apart estimates into different categories. 
A client or lender might require you to submit a proposal based on bid 
items. Some contractors even use bid items internally as another way to 
track project data. The bid item categories can differ from job to job and 
are not necessarily determined by types of work performed. Once the list 
of bid items is set up for a job, you can use the bid items when creating 
the project's estimate, budget, and proposal. In addition, you can create 
unitary bills by bid item; however, you cannot job cost by bid item.
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Although primarily available through the Estimating add-on module, bid 
items can also be used with proposals generated in window under 6-
Project Management.

Profit (Estimating)

Sage Master Builder provides methods for you to manage the profitabil-
ity of individual jobs. You can set overhead and profit rates by bid item, 
cost type, or individual grid cell in a takeoff.

To use this capability, you must have the Estimating add-on module.

Markup (Estimating)

Sage Master Builder can apply different markup rates to material, labor, 
equipment, subcontracts, and five other classes of cost types that you 
choose. Markups can be applied to specific items and to an overall bid. 
Markup is applied after overhead.

To use markups, you will need the Estimating add-on module or the Ser-
vice Receivables/Inventory add-on module.
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Inventory Details

FIFO (Inventory)

The first-in first-out (FIFO) method assumes that when items are 
removed from inventory, the inventory account is reduced by the cost of 
the first item acquired in inventory. This method more closely mirrors the 
actual physical inventory process. Assuming that the costs to acquire 
inventory are subject to inflation, a FIFO cost flow assumption results in 
lower cost of goods sold, higher net income, and thus a higher tax liabil-
ity.

Only weighted average costs (WAC) are used in job costing. Sage Master 
Builder provides an Inventory Variance Reconciliation report to recon-
cile the general ledger to jobs.

To use FIFO for inventory, you will need the Service Receivables/Inven-
tory add-on module.

LIFO (Inventory)

The last-in first-out (LIFO) method assumes that when items are 
removed from inventory, the inventory account is reduced by the cost of 
the most recently acquired item existing in inventory. Assuming that the 
costs to acquire inventory are subject to inflation, a LIFO cost flow 
assumption results in higher cost of goods sold, lower net income, and 
thus a lower tax liability.

Only Weighted Average Cost (WAC) amounts are used in job costing. 
Sage Master Builder provides an Inventory Variance Reconciliation 
report to reconcile general ledger to jobs.

To use LIFO for inventory, you will need the Service Receivables/Inven-
tory add-on module.

Weighted Average Cost (Inventory)

The WAC method assumes that when items are removed from inventory, 
the inventory account on the general ledger is reduced by the average 

Note: 
We recommend that you consult with your accountant and tax 
advisor before selecting an inventory valuation method in Sage 
Master Builder.
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cost of all items existing in inventory. This generates an average cost of 
goods sold, net income, and an average tax liability of the specific part 
being removed.

Only WAC amounts are used in job costing. Sage Master Builder pro-
vides an Inventory Variance Reconciliation report to reconcile general 
ledger to jobs.

To use WAC costs for inventory, you will need the Service Receivables/
Inventory add-on module.

Inventory Allocation (Inventory)

Inventory moves into the inventory control system through payable 
invoices, service receivables credits, or purchase order receipts. Once in 
the system, you use 12-2 Inventory Allocation to post to job costs, to 
track movement among locations, and to place stock on hold. You can 
also post transactions to the general ledger for the consumption of stock 
items by your company, the loss or shrinkage of stock items, and the 
revaluation of stock.

To use 12-2 Inventory Allocation, you will need the Service Receiv-
ables/Inventory add-on module.
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Payroll Details

Employee (Payroll)

An employee is someone your company pays on a salaried or hourly 
basis. To set up employees you create an employee record for each 
employee who works during the calendar year. The record stores per-
sonal and work-related information, and acts as the source for each 
employee's hourly pay rates, salary rates, or paygroups. In addition, you 
can accrue sick and vacation time, provide direct deposits for employees, 
and automatically recover payroll advances.

Employee Position (Payroll)

Employee positions determine how you post gross payroll costs to the 
general ledger (and job costs). Create employee positions that represent 
the type of work performed by employees such as office workers, job 
supervisors, and laborers. The list does not need to be complex; you must 
create at least one employee position.

After creating the employee positions, assign them to employee records. 
When you post a payroll record, Sage Master Builder looks at the posi-
tion in an employee's record, and the ledger accounts in the employee 
positions table.

You can also add a department to each position. When you post a payroll 
record, Sage Master Builder first looks to the job record for a department 
number. If Sage Master Builder does not find a department number in the 
job record, it next looks to the cost code. If the cost code does not contain 
a department number, Sage Master Builder then looks to the employee 
position.

Paygroup (Payroll)

Paygroups are an important component to manage wages and benefit 
packages for employees whether they are working in union shops or 
open shops working prevailing wage projects. You can include the pay-
groups in the employee record or in the job record to provide the correct 
paygroup when entering timecards. The paygroup then becomes the 
source for wages and benefits on the timecard lines.

For union shops, set up a paygroup for each combination of pay scales 
and benefits packages that you need to report. Then assign the appropri-
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ate paygroup to each employee record. During timecard entry, Sage Mas-
ter Builder assigns the paygroup from the employee record to each 
timecard line.

In open shops, the requirements between the prevailing wage project can 
vary, and employees can work under a variety of pay categories. For each 
prevailing wage project, set up the appropriate paygroups for each com-
bination of pay scales and benefits packages that you need to report.

Each union or prevailing wage project has specific requirements as to 
how the benefits are calculated. To manage the different benefit pack-
ages, you can assign an independent set of payroll calculations to each 
paygroup. It is important to review each benefit you provide and deter-
mine if it meets the requirements set forth by the governing agency. If 
not, you will need to create a new payroll calculation.

Paygroup Benefit (Payroll)

Paygroup benefits provides a simple way to link a specific payroll calcu-
lation with a whole paygroup. With this feature you can easily customize 
the benefit rates used for specific pay groups.

Payroll Calculation (Payroll)

Payroll calculations act as the rules for computing deductions, benefits, 
and employer costs. You can manually set up payroll calculations or cre-
ate the set of standard calculations supplied by Sage Master Builder.

Payroll calculations are such a key item of your setup that you may wish 
to review them with a business partner.

Payroll calculations are used for much more than just calculating 
employee benefits and costs. They can be a key tool for allocating labor 
costs to individual jobs.

Daily Payroll (Payroll)

Daily payroll entry is required if you need to allocate equipment to jobs.

With Daily payroll entry you enter payroll data for all the employees for 
a single day as well as allocate equipment use. From the daily entries, 
you can generate daily reports to review the daily costs of labor and 
equipment use. Daily payroll entry allows you to enter times for employ-
ees who worked jobs or repaired equipment, and times for equipment 
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use. Use the payroll records entry to enter records for salary, bonuses, 
adjustments to deductions and benefit balances, startup data, advances, 
or third-party sick pay.

At the end of a payroll period, you can convert the daily payroll records 
into timecards. Each timecard contains the hours worked by an individ-
ual employee. After conversion, you can still review timecards in the 
Payroll Records window.

Whether you use daily payroll or payroll records for capturing your pay-
roll data will depend upon how you manage your field payroll, how often 
you collect data, and how often you enter it.

Union Payroll (Payroll)

Sage Master Builder supports union payroll with both payroll calcula-
tions and specific union payroll reports.

After you have identified your unions, most of the details of union pay-
roll are handled via paygroups. Please review the paygroup concept.

Specialized union reports are available which show the details of all ben-
efit calculations on either a paygroup or employee basis. 

Workers’ Compensation - Split Rates (Payroll)

In a split rate system for workers' compensation, a category of work uses 
two different rates. Some states, such as California, use a two-tiered sys-
tem of rates based on employee pay. The wages an employee earns deter-
mines the rate at which the insurance company computes Workers' 
Compensation.

Sage Master Builder also allows one employee to be charged at different 
rates at a job depending upon the task being performed. This feature 
offers the potential for great savings by the contractor.

About workers’ compensation classification (Payroll)

Sage Master Builder provides methods for you to handle virtually any 
classification of workers’ compensation for your employees. Taking full 
advantage of this capability is key to minimizing your labor burden.

You can set up workers' compensation codes, rates, and experience mod-
ifiers. Sage Master Builder uses the table in conjunction with the work-
ers' compensation payroll calculation to compute the premium for each 
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code category. How you set up the workers' compensation codes depends 
on the requirements for each state:

• Some states use two-tiered codes, where two rates apply to a single 
category of work.

• Some states require the employer to pay for general liability insur-
ance. Often the liability rates are based on the risk groups, but are not 
affected by the experience modification.

• Some states use a dollar per hour rate instead of a percent; some use 
both.

• Some states do not require subcontractors to carry workers’ compen-
sation insurance. Often the general contractors carry the liability 
insurance burden for the subcontractor.

As you set up your system, use the compensation codes from the 
insurer's policy or report whenever possible.

Direct Deposit (Payroll)

Using direct deposit, you can deposit funds in up to four different bank 
accounts for an employee.

Banks require electronic delivery of payroll information by companies to 
provide employees with direct deposit. Sage Master Builder supports the 
creation of a file in automated clearing house (ACH) format. You can 
then send this file to your bank. Your bank will extract records from the 
file and create files that are routed through ACH providers to the various 
employee banks. 

Trial Compute (Payroll)

This is the initial calculation of payroll during a payroll cycle. During a 
compute, the program calculates the wages, deductions, benefits, and 
employer costs for each timecard.

After a trial-compute, you can review the individual payroll records, 
check the accuracy of the payroll calculations, and make any final adjust-
ments. Before the final-compute, you can override a payroll calculation 
in a specific record and provide the amount you want Sage Master 
Builder to use.
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Payroll Final Compute (Payroll)

At this point payroll expenses are posted to job costs. When a final-com-
pute is completed, Sage Master Builder changes the status of the records 
to computed and creates the job costs. In the employee records, the pro-
gram updates the quarterly and year-to-date totals for gross wages, Social 
Security, and Medicare. The program also updates the quarterly totals of 
the payroll calculations.

Once you have finalized payroll, you can print payroll checks and post 
the records. If the posting period has changed between the time of the 
final compute and posting to the general ledger, Sage Master Builder 
updates the posting period of the job cost records.

Post To General Ledger (Payroll)

This is the final step of payroll processing. When you post payroll, Sage 
Master Builder:

• Debits gross payroll.

• Posts job costs to the direct expense account. If you have selected the 
Post Payroll to WIP check box in the job record, payroll posts to a 
WIP account. If the WIP account uses subsidiary accounts, payroll 
posts to a subsidiary account that uses the job number as the account 
number.

• Posts equipment repair or maintenance costs to the equipment/shop 
account.

• Posts all remaining costs to the overhead or administrative account, 
which is determined by the employee position.

• Debits payroll expenses to the ledger accounts as indicated in the 
payroll calculation.

• Credits net payroll to the checking account entered in the Payroll 
Posting window.

• Credits the ledger accounts as indicated in the payroll calculations.

Sage Master Builder provides the capability to post payroll records to the 
general ledger in detail or in summary. 
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Timecard (Payroll)

Sage Master Builder offers a variety of ways to create timecard records 
for your employees. You can directly enter timecard records on an 
employee by employee basis or use daily payroll reports to enter the 
records by day for many employees. At the press of a button, you can 
then create detailed Timecard records that will be job costed.

After timecards have been created, however, the costs are available on 
committed cost, cost to complete, and cost vs. budget reports for you to 
manage jobs. When you run Final Compute in 5-3 Compute Payroll, 
Sage Master Builder posts the costs for labor to the general ledger and 
creates the job cost records.

Several third-party vendors provide applications for timecard entry via 
the Web and PDA devices. Please review this page: 
http://www.sagecre.com/partners/development_partners/
complementary_products 

Federal and State Filing (Payroll)

Aatrix is a leading provider of tax-form filing and compliance services. It 
is in business to help you complete state and federal payroll reports 
directly from your software. Now that Aatrix has been integrated into 
Sage Master Builder, you have the ability to fill out report forms, print 
the forms, and then send them to federal and state entities. 

In addition, if you enroll with Aatrix and set up an account, you can file 
reports electronically through Aatrix while working within Sage Master 
Builder. Filing electronically through Aatrix is fee-based. 

Certified Payroll (Payroll)

To verify the payment of prevailing wages to employees working a 
Davis-Bacon or prevailing wage project, many government agencies 
require contractors to submit certified payroll reports. The governing 
agency determines the frequency with which you must submit the 
reports.

Sage Master Builder allows you to select payroll data for inclusion in 
these reports either at the detailed payroll record level or at the job/
employee level.
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Production and Project Management Details

Project Work Center (Project Management)

This feature enables you to view important data and manage all your jobs 
from one location. The Project Work Center is highly customizable for 
each user's needs.

Job information is available directly from the Sage Master Builder desk-
top by creating the desktop shortcut icon from the 6-Project Manage-
ment menu.

Project Work Center displays the following information for a selected 
job:

• A customizable menu tree displaying accessible menu items.

• Contact and current financial information about the selected job.

• Items selected for the Hot List, including: 

• Invoices

• Change orders

• Purchase orders

• Subcontracts

• Proposals

• Progress bills

• Loan draws

• Unitary bills

• Recurring payables

• Recurring receivables

Using document control, you can display more items in your Project 
Work Center, such as:

• Requests for information

• Requests for proposals

• Transmittals

• Submittals
74



 Additional Details
• Plan records

• Daily field reports

• Punch lists

• Correspondence

Hot List (Project Management)

The hot list is a record of items that require immediate attention. You can 
display a hot list by job or by supervisor. You can then drill down to 
review a specific record.

Hot list items are selectable on an item-by-item basis. You may set the 
hot list to be selected for all items of a given type by using the field 
default capability of Sage Master Builder. You can include the following 
standard information on the hot list. 

• Invoices

• Change orders

• Purchase orders

• Subcontracts

• Proposals

• Progress bills

• Loan draws

• Unitary bills

• Recurring payables

• Recurring receivables

• Requests for information

• Requests for proposals

• Transmittals

• Submittals

• Plan records

• Daily field reports
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• Punch lists

• Correspondence

Grid Files (Project Management)

Grid files provide a quick way to build:

• Budgets

• Takeoffs

• Proposals

• Schedules

Essentially, the grid files are parts of full grids that can be imported into 
the four named documents. This provides a handy way to duplicate com-
plex work from job to job.

Change orders (Project Management)

The 6-4-1 Change Orders window provides functionality for managing 
changes to a prime contract or subcontract. Change orders allow you to 
track changes independent of a project’s budget, providing a clear audit 
trail for pending, approved, and refused changes.

Depending on the type of change work you need to perform, you can 
enter change orders that alter the job’s budget, proposal, or subcontracts, 
or any combination of the three. On the Prime Change Details tab, you 
can enter changes to costs that affect the bid amount. In the Budget and 
Sub Change Details tab, you can enter cost changes that affect your 
budgeted costs such as subcontract changes, or work for which you do 
not want to charge the client.

Change orders are now more closely integrated with subcontracts. When 
you create a change order using the 6-4-1 Change Orders window for a 
subcontract, the program displays information on the 6-7-1 
Subcontracts window in columns named Changes, New Contract, and 
Remaining. This tight integration provides more control over your 
contracts and your invoicing by providing accessible information. 

Direct Expense (Project Management)

When you post a transaction to the Direct Expense or WIP range of 
accounts, Sage Master Builder prompts you to create a job cost record in 
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the Job Cost Distribution window. Job-cost records do not impact the 
general ledger.

Committed Costs (Project Management)

This reporting capability summarizes “paid” information and “commit-
ted but yet not paid” information on a job-by-job basis. This report 
includes unposted payroll and open purchase orders.

It calculates the remaining budget based on the “budget plus changes” 
minus “costs to date and committed costs.”

This powerful capability shows your job profitability while the job is in 
progress, and you can take corrective action if needed.

Cost to Complete (Project Management)

This is a key facility for you to manage your business and make sure 
projects are not getting out of control.

With the cost-to-complete function, you can generate a report estimating 
the costs necessary to complete a project currently under construction. 
When you select the job and phase and update the data, the program 
retrieves the current budget, job costs, and the gross wages for uncom-
puted payroll records. Over the course of the project, you can update the 
current budget and job costs in the Cost to Complete window to create a 
new report.

Enter the estimated percent of work completed or costs to complete the 
project, and then calculate the report. If you provide the percent of work 
completed, the program computes an estimate of the remaining costs to 
complete the project and the amount by which you are over or under bud-
get. If you provide the estimated costs to complete the project, the pro-
gram computes the percent of work completed and the amount over or 
under budget.

While the computed payroll records include the labor burden, the gross 
wages for uncomputed payroll records does not. To increase the accuracy 
of the report, you can provide a labor burden rate, which the program 
uses to calculate and add in the estimated labor burden for uncomputed 
payroll record
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The Cost to Complete report relies on accurate and up-to-date job costs. 
Be sure to post all job costs and enter any recent change orders before 
updating the report.
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Reporting Details

Form Design (Reporting)

Every report, document, or letter that you generate uses a form design. A 
form design is a template for the layout of a page or pages. Using 13-5 
Form/ Report Page Design, you can edit any of the form designs sup-
plied with Sage Master Builder, or create new forms. You can change the 
graphic elements and layout of the form, as well as change the boiler-
plate text. 

Form design is used for customizing items such as checks and reports. It 
will most probably be needed with AP, Payroll, Equipment, and GL 
checks. Consult with a business partner when working on payroll checks.

Using 13-5 Form/Report Page Design, you create the page layout for a 
single page form or a multi-page form that includes text, fields, and cal-
culated fields. 

Form design allows you to change the look of any document to fit your 
needs. You can create an endless variety of new forms and documents for 
your business without having to learn other complex software. Form 
design can be used to create business letters, mailing labels, complex 
contract documents, custom check forms, special report page formats, 
change orders, invoices, and many other documents that you use every 
day. This eliminates the need for expensive pre-printed forms since 
everything can be printed on your standard printer paper.

Report Writer (Reporting)

13-3 Report Writer provides tools that allow you to create custom 
reports to access information stored in the Sage Master Builder data-
bases. With the 13-3 Report Writer, you can modify existing reports or 
create entirely new reports for your company's needs.

Before creating a report, it is important to understand how the Report 
Writer and Form Design work together. In 13-5 Form/Report Page 
Design, you create the page layout for a single page form or a multi-page 
form that includes text, fields, and calculated fields. Most form designs 
also have a detail box, which indicates to Sage Master Builder where the 
details of the report will be placed.
79



Chapter 3
In the 13-3 Report Writer, you create the body of the report that appears 
in the detail box of the form design. In the design of the report details, 
you can include text, fields, and calculated fields. In addition, you can 
control when the report prints on a new page or an entirely new form.

13-3 Report Writer provides functionality so that you can associate a 
specific form design with a report. When you select the report for print-
ing, Sage Master Builder automatically selects the associated form 
design. In addition, you can determine the location of the report in Sage 
Master Builder menu system. 

You can create new reports from scratch, or you can use existing reports 
as the basis for new reports. The Report Writer Wizard can also guide 
you through the process of designing a custom report.

Scheduling Details

Task (Scheduling)

A task is an event that has a defined beginning and ending. Not only can 
you create tasks for work to perform, but you can also create tasks for 
other important events such as inspections, sending billings, or ordering 
materials.

Tasks can be created as result of exporting from the Takeoff or can be 
created directly in the Scheduling module of Sage Master Builder.

In addition to simply managing the job, Tasks can help you project cash 
flow needs and select needed Purchase Orders to issue.
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Service Receivables Details

Service Work (Service Receivables)

The Service Receivables add-on module handles service contracts, 
service routes, service dispatch, on-call work orders, quotes, and point-
of-sale and billing-of-service work materials. Because Service 
Receivables fully integrates with the Inventory add-on module, you can 
keep inventory up-to-date based on service work completed. 

Using Service Receivables, you can review information about equip-
ment installed at multiple client sites and track how the equipment is 
used. You can use service truck inventory to assign parts to trucks or 
warehouses. In addition, you can turn your estimates into service work 
orders.

Work Orders (Service Receivables)

A work order is one step of the complete service receivables process. 
The general flow is from “quote” to “work order” to “invoice.” The ser-
vice work process is quite flexible, however, and your business may use 
these capabilities in an abbreviated fashion.

Work orders can be set up and reviewed in a one-by-one fashion but can 
also be seen and manipulated in the dispatch board. The drag and drop 
capabilities of the dispatch board update times and assignments for work 
orders.

Service Routes (Service Receivables)

Regularly scheduled work, determined in the terms of the contract, is 
referred to a service route. A route might entail routine inspection, main-
tenance, or performance of work.

For instance, a street sweeping company sweeps the parking lots for 
local shopping centers every week. On Mondays and Tuesdays, the com-
pany sweeps lots on the north side of town. On Wednesdays and Thurs-
days, the company sweeps lots on the west side of town. And on Fridays, 

NOTE: 
To use service receivables functionality, you will need the Ser-
vice Receivables/Inventory add-on module.
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the company sweeps lots on the south side of town. The lots swept on 
each day represent a different route.

Service Locations (Service Receivables)

For service work, you can set up a table of the different locations that you 
must service for each client. You can use the phone number of the loca-
tion for quick lookup of clients.

Contract (Service Receivables)

Service receivables support a contract feature for recurring work using 
the contract data for recurring billing. Contracts can create invoices 
directly without creating a work order. Use the contract in situations 
where the same amount is billed each time. For each client, you may 
have multiple contracts.

Dispatch Board (Service Receivables)

Use 11-3 View Dispatch Board to manage work orders and technician 
assignments. You can assign technicians to work orders, move work 
orders to different days, even delete work orders altogether. The Dis-
patch Board also displays travel time and appointments from the calen-
dar. In fact, when you add time off to the Dispatch Board, it is added to 
the calendar.
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Customer Resources
This chapter provides information about the following:

Sage Master Builder Printed and Printable Documentation

Customer Support Resources

Training Resources

Business Partners

Business Forms
83



Chapter 4
Sage Master Builder Printed and Printable 
Documentation

Sage Master Builder Product Overview

Sage Master Builder Product Overview provides background 
information to help you understand the core functionality of Sage Master 
Builder and how to use it to manage your business. If you are new to 
Sage Master Builder, then we highly recommend that you read the 
specific background information about the tasks that you will perform. If 
you are a company owner or administrator, we recommend that you read 
all the information in this guide. 

Sage Master Builder Installation and License Administration Guide

The Sage Master Builder Installation and License Administration Guide 
provides explicit information about how to install Sage Master Builder 
and set up the software in your specific environment. It also provides 
information on how to set up and administer licensing and manage 
license reservations. This guide is a “must read” for all systems 
administrators and business owners.

Sage Master Builder User Guide

The Sage Master Builder User Guide is a printable PDF version of the 
Sage Master Builder Help. It provides extensive explanation of Sage 
Master Builder functions and tools as well as hundreds of procedures for 
completing tasks.

Sage Master Builder Release Notes

The Release Notes document provides information about enhancements 
and previously reported issues in the software that have been resolved for 
the current release. 

NOTE: 
To open this and other documents, on the main Sage Master 
Builder window, click Help > Printable Documentation > file 
name.
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It also provides, where applicable, information and comments about 
recently discovered issues that have not yet been resolved before the lat-
est software release.

Printing Sage Master Builder Documentation

Printing Sage Master Builder printable documentation

Links to the printable documentation are located under Help > Printable 
Documentation menu on the Sage Master Builder main window.

To print a Sage Master Builder printable document: 
1. On the main window, click Help > Printable Documentation.

2. From the menu list, select the printable document you want to open.

Adobe Reader opens and loads the guide.

3. From the File menu, click Print.

4. To print a section of pages, from the Adobe Reader Print window, 
select Print Range > Pages from, and type a range of pages.

IMPORTANT: 
You must have the Adobe®Reader® installed on your computer 
to view and print Sage Master Builder guides. To download this 
free software for viewing and printing documents in PDF for-
mat, visit  
http://www.adobe.com/products/acrobat/readstep2.html
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Customer Support Resources

About customer support resources

Sage Master Builder offers a variety of customer support resources. 

Sage Knowledgebase
You can access the Technical Support Knowledgebase 24 hours a day, 
seven days a week for solutions to frequently asked questions. You can 
also find software alerts and notices, release guides, and year-end close 
information there too. 

To access the Technical Support Knowledgebase: 
1. Click https://customers.sagenorthamerica.com/irj/portal/anonymous/

login. 

2. On the Welcome page, in the left column, click Knowledgebase 
Search to open a list of products. 

3. Complete Step 1 by selecting Sage Master Builder from the list of 
products. 

4. Complete Step 2 by entering a search term in the box.

5. Click Search.

The search results appear below the box. 

Release Updates
To get the latest information about this release, log on to the Customer 
Portal, 
https://customers.sagenorthamerica.com/irj/portal/anonymous/login. 
 Then click Support > Documents > For Customers > Sage Master 
Builder > Release Materials. 

TIP:
This is the same online tool our support staff uses when respond-
ing to calls from service plan customers. 
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 Customer Resources
Online Support
If you would like assistance with a solution and your service plan 
provides online technical support:

1. Log on to:  
https://customers.sagenorthamerica.com/irj/portal/anonymous/login. 

2. Then click Self Service > My Requests > Customer Support 
Ticket.  
This sends your request directly to Customer Support.

Phone Support
If you need help and your Service Plan provides support assistance, call 
Customer Support at 800-866-8049. Support hours are Monday through 
Friday from 6 a.m. to 5 p.m. PT (Pacific Time).

Upgrade your Service Plan
If your service plan does not provide online technical support and you 
would like to add or upgrade a service plan:

1. Call 800-585-7098, or log on to  
https://customers.sagenorthamerica.com/irj/portal/anonymous/login. 

2. Click Self Service > My Requests > Customer Service Request. 

Remote Assist Tool
The Remote Assist Tool allows Sage Customer Support representatives 
to access your systems and data remotely through your computer to 
provide support services to you and your company. You can access the 
Remote Assist Tool from a Help menu link on the Sage Master Builder 
main page. Point to Help > Customer Resources > Technical Support 
> Remote Assist Tool.

Customer Forums
Exchange information with other Sage Master Builder customers. Log on 
to:  
https://customers.sagenorthamerica.com/irj/portal/anonymous/login. 
On the Web page Home tab, find and click Forums.
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Upgrade Your Service Plan
If your service plan does not provide online technical support, you may 
add or upgrade a service plan by calling 800-858-7098 or by logging on 
to:  
https://customers.sagenorthamerica.com/irj/portal/anonymous/login. 
Then click Self Service > My Requests > Customer Service Request.
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Training Resources

About training options

Learning to use Sage Master Builder software has never been easier! 
Whether you choose to take online classes from Sage, participate in 
classroom training, or work directly with your business partner, you will 
learn how to use Sage Master Builder to support your business. Contact 
your business partner to find out about training options or visit 
www.sageu.com/masterbuilder. 

Overview of customer classes
Online classes help make learning Sage Master Builder convenient. Each 
instructor has years of experience using Sage Master Builder and will 
lead you step-by-step through the class material. 

Online classes allow you to view the instructor’s computer screen as he 
or she demonstrates Sage Master Builder software. Once you register for 
your class via Sage University, you will receive email communications 
that tell you how to access the training. Because the classes are live, you 
can ask questions and benefit from hearing other students’ questions. 
Classes cover all aspects of Sage Master Builder, including project man-
agement, estimating, scheduling, and payroll. For more information, visit 
www.sageu.com/masterbuilder. 

Getting started with training
All customers should begin with our New Customer Training (NCT) 
series which is included in our Essentials Training Package in recorded 
format for 24/7 access. These classes include an overview of the Sage 
Master Builder system and its features. Customers that prefer live online 
training can register for the Realtime Learning version of these NCT 
courses. For more information, visit  
www.sageu.com/masterbuilder. 
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Business Partners

About Business Partners

To serve you better, Sage Master Builder products and services are 
available to you through an authorized network of business partners.

Your business partner is available to serve you, from simple how-to 
questions and hands-on demonstrations, to installation, implementation, 
and training. They're fully equipped to help you get where you want to 
be. For more information please contact your Sage Master Builder 
business partner.
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Business Forms

Sage Construction and Real Estate Forms

Sage Master Builder is designed to work with generic checks and forms 
that are available from many sources. There is no single vendor that 
customers must use; however, you can get a complete portfolio of forms, 
tax forms, and checks through Sage Construction and Real Estate Forms 
by calling 800-760-7929 or by visiting http://www.sagecreforms.biz/.
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